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SECTION 1. IDEAS OVERVIEW 

1.1 INTRODUCTION 

IDEAS is a high-fidelity dynamic simulation tool for the engineer. It provides capabilities throughout the 

entire process plant life cycle. 

Dynamic simulation is the simulation of real-world processes in which the results represent the material 

and energy flows of the process in a dynamic, or time-varying, fashion. 

The fidelity of a simulation is a measure of its accuracy. Simulation models of process equipment strive to 

accurately represent actual equipment operation. The closer a model’s results match the actual operation, 

the higher the fidelity of the model. IDEAS is a high-fidelity simulation software package encompassing the 

first principles of physics to describe physical, chemical, and electrical processes. 

IDEAS is unique in that it provides a single tool for all of the major phases of a process plant’s life cycle: 

 Conceptual Design 

 Detailed Process Design 

 Detailed Control Design and Analysis 

 Control System Checkout 

 Operator Training  

 Operations Management 

Traditionally, other dynamic simulation tools have been useful for one or two of the above-mentioned 

areas but not the others. IDEAS is the first high-fidelity simulation tool that can be used successfully in all 

of these areas. 

The graphical nature of IDEAS allows the user to structure a dynamic model by retrieving icon-based 

"objects" from various libraries and assemble them on a drawing-like worksheet. These objects generally 

have a one-to-one correspondence with actual process equipment, i.e., pumps, valves, tanks, 

transmitters, controllers, etc. The user, therefore, can create a model by merely creating a P&ID-like 

picture of the process. Individual equipment characteristics such as pipe dimensions or pump curves can 

be specified by filling in Dialog Box information for each object. The Dialog Boxes can be accessed by 

double-clicking each object with the mouse. 

The "objects" that are used to create a model reside in various libraries. These libraries are organized into 

logical groups such as Pipes and Valves, Pumps and Compressors, Analog Controls, etc. Every time an 

object is retrieved from a library and placed onto a worksheet, an "instance" of that object is created. Each 

instance of the same object is identical in terms of the code (programming) that is executed when the 

model runs. 

The objects are designed to "Plug and Play" with each other. They can be interconnected in a virtually 
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infinite number of combinations to create complex models. The objects have color-coded connectors. The 

user simply has to connect the green connectors to the green ones and the red connectors to the red 

ones. These connections result in the connection protocol explained in Appendix A. 

Once a model is created with objects retrieved from the libraries, and all the necessary information is 

entered into the Dialog Boxes, the simulation is ready to “run.” No other programming, "subroutine" 

connections, or other software manipulations are required. The flows in the pipes and valves as well as 

the associated pressures throughout the piping network are automatically solved, displayed in the dialog 

boxes, and are made available to transmitters, plotters, etc. This program structure thus evolves into a 

dynamic simulation tool that is high in fidelity and can be used by any process engineer.  

1.2 TYPES OF MODELS 

1.2.1 DYNAMIC MODELS: IDEAS GOLD 

Dynamic models provide the information necessary for optimal process and control design. Process 

constraints and bottlenecks are often experienced during the transition between production rates or at 

start-up, shutdown, or upset conditions. In order to use a simulator for process control design and 

analysis, the simulator must be dynamic to model the time-varying parameters of interest. IDEAS provides 

all of these dynamic capabilities: 

 First principles dynamic simulation of mass, energy, and momentum in multi-component streams: 

 Highly accurate simulation of flow for both compressible and incompressible materials 

 Object characteristics modeled to a high degree of detail 

 Material Properties defined over a wide range of conditions 

 True interactive operations allow model modifications and "what if?" analysis 

 Rapid convergence for complex, recycled flow, real-world process models 

1.2.2 MACRO MODELS: IDEAS BRONZE 

Using IDEAS dynamic objects requires the user to specify details about the equipment that may not be 

known (or be relevant) during early stages of design. For example, in the conceptual design phases of a 

project, the user may need an overall plant energy and mass balance but may have no interest in pressure 

drops in pipes, specific pump curves, or valve sizes. IDEAS/Macro provides the tools to construct complex 

models of industrial processes using a number of generic objects such as mixers, splitters, separators, 

flow, and pressure setters, supervisors, and a multi-equation object. The information about the process 

equipment required to make such models is much lesser than that required for the IDEAS dynamic 

objects. 

The IDEAS Macro objects are fully compatible with the IDEAS dynamic objects. Any model, which starts 

as a Macro (steady state) model can evolve into a dynamic model as parts of the worksheet are replaced 

by dynamic objects, provided detailed information about the process and equipment becomes available. 

As a result, a final process model may consist of some dynamic objects and some simpler Macro objects. 
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1.3 DYNAMIC FINANCIAL MODELS (TIED TO PROCESS) 

Since the ultimate aim for most industrial processes is profit, the cost of various portions of the process 

under varying production conditions is of great interest. IDEAS Financial provides the tools to track 

manpower, material, and energy costs dynamically, as the model runs, and to analyze the process to 

optimize profit. These costs can be accumulated, split, and reported. 

With the cost per unit as the defined parameter and the number of units as the measured variable, the 

IDEAS Financial objects calculate the associated cost on a Per-Step and Total basis. The Operating Cost 

Delta object is designed to average and annualize profit and to determine the difference in cost between 

the current and previous simulation runs. 

1.4 DISCRETE EVENT AND CONTINUOUS MODELS 

The IDEAS Discrete Events product is a separate but compatible product that is available as an option for 

use in projects. All references to the Discrete Event Library objects contained within the license manual is 

included for informational purposes only and in no way entitles the reader, or manual owner, to a license 

or ownership of this library. 

Continuous modeling is used for processes in which the products are continuous streams (i.e., a flow of 

pulp slurry, a ream of paper, steam in a pipe, etc.). Discrete modeling, on the other hand, is used for 

modeling processes that result in discrete products (i.e., a box of cereal, a machined part, a packaged roll 

of paper, etc.). IDEAS is unique in its ability to provide both Discrete Event and Continuous modeling 

capabilities. These two different types of simulations are supported by IDEAS and can be used together 

on the same worksheet. 

1.5 SCAN CLASS 

A dynamic model is typically operated at a specified rate, or time step, called Delta Time. A scan through 

the model and solution of the piping network occurs every Delta Time. Often there is a special need for 

one or more objects to run slower or faster than the basic model’s Delta Time rate. IDEAS allows the user 

to specify multiple scan rates, or scan classes, to accomplish this. The user, for example, may want to 

simulate a DCS analog controller that has a sampling rate of 0.25 seconds. The model can be set to 

execute every 0.1 seconds and the controller object in the model can execute every 0.25 seconds. This is 

accomplished using the Discrete/Continuous Executive object in the Executives library. For more 

information on this feature, see Appendix B. 

1.6 SNAPSHOT 

The Snapshot feature allows the user to save complete sets of model operating parameters. These 

operating states can then be loaded into the model, and the model can be started at this operating 

condition. This feature easily allows the user to return to operating states that may have taken many hours 

to attain the first time. More details on the Snapshot functionality can be found in the Executives library 

help text. 
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1.7 MATERIAL PROPERTY DATABASES 

High-fidelity simulations require comprehensive material properties database capability. Each object must 

have access to enthalpies, densities, etc., for each component defined in the model. IDEAS provides 

several material properties databases for users in different industries: 

 IDEAS MP database with steam tables 

 Mining MP database with non-ideal mixtures (add-on)  

 VMG MP database with VLE model (add-on) 

 OLI MP database with electrolyte models (add-on) 

More information on Material Properties objects (as well as how to create new material properties) can be 

found in the Material Properties library help text. 

1.8 PUMP AND VALVE SIZING CAPABILITY 

IDEAS can be used for detailed process and control design. After the piping dimensions and elevations 

are entered into the model, the user can easily determine the size of pumps and valves in the model by 

using the automatic pump and valve-sizing feature. A pump and valve pair can be simultaneously sized to 

determine the head requirement for the pump and the Cv or Cg of the valve. 

1.9 SOLVING PIPING NETWORKS 

Very complex piping networks can be created with IDEAS. Networks can have many flow paths, recycled 

flows, intermittent reverse flows, and other characteristics that make an accurate flow and pressure 

solution difficult to achieve. Some simulators approach this problem by creating a very large matrix of 

equations or several artificially separated smaller matrices that must be solved simultaneously for every 

scan of the simulation. When things are working properly, this technique works well. However, by 

artificially separating the matrix into smaller matrices, a technique called "islanding", compromises are 

made that adversely affect model fidelity. If the model has areas in the piping system, which are extremely 

difficult to solve, as most complex models do, these solution techniques can diverge and produce invalid 

data. When these matrix techniques diverge, it becomes very difficult for the user to determine where the 

problem occurred since the entire solution is invalid. When dynamic models are solved, this approach 

often requires that steady-state models be constructed first to obtain proper initial conditions to prevent 

invalid solutions. 

Other simulators rely exclusively on a "sequential modular approach" in which calculations are made 

step-by-step across the worksheet with equations solved by iterating through multiple passes through the 

worksheet. IDEAS has a pure steady-state mode available that uses this approach. For a fully dynamic 

simulation, IDEAS calculates solutions using proprietary hybrid solver approach by combining the best of 

the simultaneous and sequential modular approaches. There is no need to select an overall numerical 

integration method, as IDEAS automatically adapts to the specific stiffness of the model without user 

intervention or knowledge of numerical techniques.  
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Each sequential modular pass through the worksheet is followed by a simultaneous series of iterations, 

which assures convergence of the worksheet at each time step (default = 1 second) to the accuracy 

specified by the user in the solver dialog. Every pass through the worksheet is followed by this global 

convergence calculation. In this manner, the pressure-flow network is solved sequentially through the 

model each scan, followed by the global simultaneous emulation convergence procedure. If any part of the 

model experiences a problem, it is isolated to that particular area of the model and it is easy to find via 

error messages and/or highlighting of the offending object. 

The IDEAS Solver-Fluid Flow automatically solves very complex piping arrangements without resorting to 

"islanding" and can achieve the same convergence accuracy as the matrix methods (pure simultaneous 

solution methods), yet is considerably easier to use. In addition to the global solver, complex individual 

objects solve their own internal equations using either sequential or purely simultaneous solution 

techniques as selected by the object developer. The total combination of approaches, coupled with 

automatic monitoring of global convergence without user intervention, makes the IDEAS proprietary hybrid 

solver very powerful (Appendix A provides more information about the IDEAS pressure-flow solution 

technique). 

1.10 CONTROL SYSTEMS 

1.10.1 SYSTEMS EMULATION 

Control function libraries, allow the user to emulate vendor-specific control strategies within the simulator. 

This option allows the control design as well as the process design to be verified. Since the controls and 

the process model are part of the same simulation, a complete operating process can reside in one 

simulator PC on a design engineer’s desk. 

1.10.2 SYSTEMS DESIGN 

IDEAS dynamic process simulation provides an excellent tool for control system design. Control system 

configurations and strategies can be designed and evaluated using a detailed model of the process 

connected to the emulated control strategy in the model itself. To optimize this process, IDEAS provides 

an optional library of specialized control design objects that perform data manipulation functions such as 

auto-correlation, plotting functions such as Bode Plots, estimation methods such as least squares fitting, 

various model structures such as ARMA, predictors such as k-step ahead prediction and control structures 

such as minimum variance control. For more information on these functions, refer to the detailed library 

documentation for the object. 

1.10.3 SYSTEMS INTERFACE 

Since IDEAS can be used in many different ways, it has the capability to connect to various other systems. 

For example, when used as an Operator Training Simulator (OTS), the simulator can communicate with a 

DCS console to provide the same operator interface that the operator would see in the real plant. This 

interface can be one of two different types.  
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If the controls for the process are emulated in the simulation, then the simulator can communicate with just 

a DCS console or PLC operator interface for operator training. If, on the other hand, the controls are to 

reside in the DCS or PLC hardware and the simulator can provide realistic process information and 

responses from the controls, the interface is between the simulator and the DCS controller hardware or 

the PLC hardware itself. This type of interface can be used for both operator training and control strategy 

checkout. A more thorough control system checkout can be accomplished by interfacing the simulator 

directly to the DCS/PLC input/output terminals using I/O Subsystem. This interface provides for the most 

thorough control system staging available anywhere and drastically reduces start-up problems and start-

up time. 

1.11 ON-LINE HELP 

IDEAS on-line help is available from the Help button located in the lower left corner of each object dialog 

box. This help can be accessed by opening the object (double-clicking the icon) dialog box and then 

clicking on the Help button. The help provides the modeler with important information about the setup of 

the object and the necessary parameters required for the object. 
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SECTION 2. MENU COMMAND REFERENCE 

This section describes the commands and menus available in IDEAS. It explains all the commands that 

appear in the menus and the circumstances in which the user might use them. 

Some of the menus are hierarchical menus. A hierarchical menu has a submenu for one or more of its 

main menu items and is indicated by a triangle pointing to the right ( ). To use a hierarchical menu, drag 

the cursor down the menu to the desired command. As the command is selected, a second menu appears 

to the right of the first one. While still holding down the mouse button, slide the cursor to the right, then 

down the hierarchical menu to the desired choice, and let go of the mouse button. 

 

Figure 1: Hierarchical Menu 

2.1 HELP MENU 

The Help menu provides information about the application on the Windows platform. 

2.1.1 ABOUT IDEAS 

Displays the version of IDEAS. 

2.1.2 IDEAS HELP 

Shows a list of help topics. Select a topic from the list and double click for more information. 

2.2 FILE MENU 

The File menu opens, saves, imports, exports, and prints model files. 

Note: The library files are opened from the Library menu described later. Most of the commands in this 

menu are the same as any other Windows programs. 
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Figure 2: File Menu 

2.2.1 NEW MODEL 

Opens an untitled model window. 

2.2.2 NEW TEXT FILE 

Opens an untitled text file window. 

2.2.3 OPEN 

Opens an existing model. As IDEAS opens the model, it also opens any libraries that are used by the 

model. Thus, there is no need to manually open libraries to run a model. Of course, if the library is already 

open, IDEAS does not reopen it. 

If the model or the library has been moved since the model was closed, IDEAS may not be able to find the 

library. The message "Searching for library xxx..." will be displayed as IDEAS searches for the library. 

Press Cancel and a standard file dialog box will be displayed prompting the user to find the location of the 

library. Once the library file is found, highlight it and select Open. 

2.2.4 CLOSE 

Closes the active window. A file can also be closed by clicking on the window’s close box in the upper left 

corner of the window. 
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2.2.5 REVERT MODEL 

Reverts the selected model or object to the last version saved to the disk. 

2.2.6 SAVE MODEL AND SAVE MODEL AS…. 

Saves the selected model or object to disk. Choose Save to save the file under the current name or Save As 

to save the file under a new name. 

2.2.7 IMPORT DATA 

Copies data from a text file into the selected table. The user can create text files in a word processing or 

spreadsheet application. A table from a dialog box or plotter must be selected for this command to be used. 

After choosing the file to be imported, the following dialog box is seen: 

 

Figure 3: Importing Data 

2.2.8 IMPORT DATA DIALOG BOX 

The user must specify how the columns in the text file are delimited (separated). Rows are automatically 

separated by returns. Check the format of the text file before choosing Import Data with the IDEAS inbuilt 

Text file editor. 

2.2.9 EXPORT DATA 

Copies data from a selected table to a text file. It works the opposite of the Import Data command. Once 

file name is given, IDEAS opens the column separator dialog box to specify what type of separator to use 

in the text file. The text file can be read in a word processing or spreadsheet application. 
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2.2.10 IMPORT DXF FILE 

Imports CAD drawings in standard DXF format from AutoCAD or other CAD programs. The drawing 

becomes a graphic image, which can be used as a background picture in the model, the notebook, or on 

an icon. In AutoCAD, the file must be a version 12 DXF file. 

2.2.11 SHOW PAGE BREAKS 

Causes IDEAS to draw a set of page boundaries on the model. These page boundaries show where page 

breaks occur if printed. 

Note: The size of a page is dependent upon the settings in the Page Setup command. When Show 

Page Breaks is chosen, this menu item has a check mark next to it. To hide page breaks, select 

this command again. Notebooks always show their page breaks. 

2.2.12 PAGE SETUP 

Sets the printing parameters for the printer being used. Choose this command after changing printers or 

whenever changing the printing parameters. 

2.2.13 PRINT 

Prints the model, its notebook, and/or the dialog boxes of the objects in the model. For more information 

on printing, see the Printing the Model section in Section 3. 

2.2.14 EXIT 

Terminates IDEAS application run. If there are any model files with unsaved changes, the user is 

prompted to save them. 

2.3 EDIT MENU 

The Edit menu contains the standard Cut, Copy, and Paste commands as well as other commands. Some 

commands are described here. Others may be seen in the ExtendSim User Manual. 
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Figure 4: Edit Menu 

2.3.1 UNDO 

Reverses the most recent action. The user can undo commands, actions, and so on. 

2.3.2 CUT BLOCKS 

Removes the selected item (such as an object, text, or numeric data from a data table) and places it on 

the Clipboard. View the current contents of the Clipboard by choosing Show Clipboard in the Edit menu. 

2.3.3 COPY BLOCKS 

Copies the selected item to the Clipboard. View the current contents of the Clipboard by choosing Show 

Clipboard in the Edit menu. The user can copy a single object, a piece of text, a group of objects and text, 

graphical objects, or numeric values from a data table. This feature is useful for duplicating parts of a 

model as well as exporting to other applications. 

2.3.4 PASTE 

Copies the contents of the Clipboard to the model. If the Clipboard contains text, an object, or a graphic 

item, the copied item is placed at the insertion point. If there is no insertion point, the item is placed in the 

upper left-hand corner of the model. 
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2.3.5 CLEAR BLOCKS 

Removes the selected item. 

2.3.6 SELECT ALL 

Selects all the items such as all the objects in a model or all the text in a field. The items selected (objects 

and text, drawing items, and so on) depend on the selection tool chosen in the tool bar. 

2.3.7 DUPLICATE 

Duplicates the selected objects. 

2.3.8 FIND 

Selects an object by its global object number. Object numbers are unique, permanent identifiers for 

objects. This command is useful on large models when looking for objects. 

2.3.9 SENSITIZE PARAMETER 

If a dialog box parameter is selected, this command opens the Sensitivity Setup dialog box. The Sensitivity 

setup dialog box allows the user to set values for sensitivity analysis. An alternate method of opening the 

Sensitivity Setup dialog box is to click on the dialog box parameter once while holding down the command 

key. 

2.3.10 SHOW CLIPBOARD 

Shows the contents of the Clipboard in its own window. 

2.3.11 OPTIONS 

The Options command from the Edit menu allows the user to specify how to run IDEAS. 

Note: This command is different from the Simulation Setup command, which only affects a single model. 

The Options command controls actions for all models. 
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Figure 5: Edit Options 

2.3.11.1 Model Tab 

Use Default Connection line Types. 

Always select the default line connection types. Default Connection line style is Right Angle: All connection 

lines drawn will snap to the right angle connection type. 

Hierarchical Blocks have drop shadows (Hierarchical Objects): It determines whether there is a shadow 

around hierarchical objects. 

Tool Tips on Worksheet: If selected, displays the help captions for objects on the model worksheet. 

Note: Help captions for the tool bar are not turned off if this choice is selected. 

Plays Sound at end of run: The default sound is played at the end of every simulation. 

Metric Distance Unit: Specifies the distance or length units in the Convey Item and Transport blocks in the 

Items Library. 
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2.3.11.2 Library Tab 

Automatic Search: When a model is opened, IDEAS will automatically search and load the libraries that 

were saved with the model. 

Library search path: Allows the user to specify a default path for library searches. 

Show Library Window dates: Allows the user to display the dates on which library was created. 

List Blocks by category in Menu: Allows the user to list the objects of a library category-wise. 

Show Legacy/Prior version library warnings: Allows the user to display any written messages and 

warnings of a library from its previous versions. 

Preload libraries: Enter names of libraries that are to be automatically opened when IDEAS is started. The 

user can type in the name or use the Browse button to locate a library and cause its name to be entered in 

the selected field. 

2.3.11.3 Programming Tab 

Tool Tips on Block dialogs: If selected, displays the variable/message dialog names for dialog items. 

Tool Tips on dialog editor: If selected, displays the variable/message dialog names for dialog items in the 

dialog structure window. 

Structure Window Opens in Front: When opening an object, IDEAS opens the object’s structure window in 

front of its dialog box. 

2.3.11.4 Model Style Tab 

This menu is used by block developers. See ExtendSim help text if this option is required. 

2.3.11.5 3D Tab 

The 3D options only apply to ExtendSim products that include 3D animation—IDEAS does not use this 

function. 

2.3.11.6 Save Print Setup Settings 

Allows the user to save the print setup options.  

Note: Make sure that the model is run at least once after this option is checked. 

Print header/Footer: Allows the user to print headers and footers for each page when printing. 
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Allow data table titles copying: The title of a data table will be copied when the data table is cloned onto 

the worksheet. 

Plotter traces default to Patterns: Allows the user to draw plotter traces with a pattern allowing traces to be 

visible on a black and white monitor. 

Save backup model files: When a Save command is given, renames the existing model to "Model 

Name.BAK," then saves the model. 

MDI Interface: The MDI (Multiple Document Interface) is off by default. 

Text menu: The Text menu is used to change the style of text selected in the model. The Border command 

draws a shadowed border around text box. The Transparent command causes the background of the text 

to be transparent. 

 

Figure 6: Text Menu 

2.4 LIBRARY MENU 

IDEAS opens libraries automatically when models are opened. To open or close a library manually, use 

the Library menu. Add objects to the model by selecting them from the open libraries listed at the bottom 

of the Library menu. The first choice in each list is Open Library Window, which opens a window listing the 

objects in the library. 

 

Figure 7: Library Menu 
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2.4.1 OPEN LIBRARY 

Opens a library file. This command causes the library name to appear in the Library menu. 

2.4.2 CLOSE LIBRARY 

Closes an open library. This command displays a dialog box of the open libraries; select the library to be 

closed from the list and click Close. 

Note: Libraries that are in use cannot be closed. 

2.4.3 NEW LIBRARY 

Creates a new library. 

2.5 MODEL MENU 

Allows the user to protect the code of blocks, set library versions, convert libraries to RunTime format, and 

edit the Startup Screen for the LT-RunTime versions. 

 

Figure 8: Model Menu 

2.5.1 MAKE SELECTION HIERARCHICAL 

Changes the selected objects into a hierarchical object and replaces them on the model with a single 

object. 

2.5.2 NEW HIERARCHICAL BLOCK 

Starts a new hierarchical object. This command opens a blank hierarchical object structure window. 



 

IDEAS™ v6.5.0 Page 17 of 58 
 

2.5.3 CONNECTION LINES 

Sets the format of the selected connections. These formats are described in detail in the section 

Connectors and Connections, in Section 3.18. The choices are: 

 

Figure 9: Connection Lines Menu 

2.5.4 SHOW NAMED CONNECTIONS 

Shows the connections between named connections. This feature is useful to show data flow in complex 

models with many named connections. 

2.5.5 HIDE CONNECTIONS 

Hides the connecting lines between objects. This is a cosmetic change that is mostly used to enhance 

presentations. Select the command again to show the connections. 

2.5.6 HIDE CONNECTORS 

Hides the connectors visible on blocks. This cosmetic change is mostly used to enhance presentations. 

Select the command again to show the connectors. 

2.5.7 CONTROLS 

Allows the user to add a control object to the model. A slider, a switch, or a meter can be added. We do 

not recommend using these objects from this menu with IDEAS, as they do not allow for saving snapshots. 

An enhanced version of these objects allowing for saving snapshots is available in the Tools library. 
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2.5.8 LOCK MODEL 

Prevents any modification of a model other than changing dialog box values. This command also hides 

most of the tools in the tool bar so that the user cannot add or change connection lines, draw elements, and 

so on. Locking models is useful if the model is given to others who are unfamiliar with IDEAS features and 

may accidentally move or delete objects. To unlock the model, choose the Lock Model command again. 

2.5.9 SHOW BLOCK LABELS 

Shows the object labels below the objects in the model. 
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SECTION 3. Mechanics 

3.1 IDEAS FILES 

There are two types of IDEAS files: models and libraries. A model shows the representation of objects and 

connections. A library is a repository of objects. When adding the function of an object to a model, select it 

from a library. 

Models are opened and closed in the File menu. When the user opens a model or creates a new model, 

the model window appears on his screen as a normal file window. 

Libraries, on the other hand, are opened and closed in the Library menu. Libraries have their own library 

windows. They are also displayed at the bottom of the Library menu. 

IDEAS can also produce text files. These files can be read by any word processor and most other text 

editors. 

3.2 IDENTIFYING THE MODEL COMPONENTS 

The IDEAS dynamic simulation model contains many parts. The model consists of objects (seen as icons) 

that are graphically connected to resemble a process. Objects are sometimes referred to as blocks. 

Embedded behind each object may be hundreds of differential and/or algebraic equations and data that 

describe the behavior of the object. Each object is stored by function in an appropriate library. The 

collection of objects for the model that resembles a P&ID is called a model worksheet. The most important 

parts of the model are the objects, the libraries from which the objects are loaded, the dialog boxes 

associated with each object, the connectors on each object, and the connections between the objects. The 

simulation itself is a series of calculations and actions that proceed along the path of the connections 

repeatedly. Each repetition is called a step or event; the model can run for as long as the user wants. 

The objects are processed from left to right and top to bottom beginning with the object at the left of the 

model. After the first step, the simulation repeats itself. When running a simulation, the user instructs 

IDEAS how long (in simulation time) the simulation should run in the Simulation Setup tab under the Run 

Menu. The section Special Features (Section 4) describes the operation of various types of tools available 

from the menu bar for model manipulation. 

When saving a model on the disk, the names of the objects as well as the locations of the libraries that the 

objects come from are saved. When opening a model, the required libraries are automatically opened. 
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3.3 IMPORTING AND EXPORTING WITH TEXT FILES 

A text file is an unformatted file created by a spreadsheet, database, or word processing program. The 

general method for creating a text file in those programs is to choose Save As from the File menu and 

specify the file format to be Text. Text files contain written text and/or formatted numerical data. There are 

many situations where the user wants to read and write text files (also known as ASCII files). These kinds 

of files can also be imported or exported in IDEAS. 

For example, the user may want to share data with a database or spreadsheet program such as Excel. 

IDEAS can save files as text documents or perform a Dynamic Data Exchange (DDE) link to a database or 

spreadsheet. The Import Data and Export Data commands in the File menu can be used to read and write 

text files in the dialog box and plotter data tables. Select the data table columns in order to import or 

export the data. 

3.4 CUT, COPY AND PASTE WITH THE CLIPBOARD 

The Clipboard is useful for passing information within IDEAS or from IDEAS to other applications. The 

user can copy and paste portions of the model and data from IDEAS text entry fields and data tables. 

Objects and model sections can be pasted into graphics applications, word processors, or other IDEAS 

models. Data from text entry fields and data tables can be pasted into any other application such as word 

processors and spreadsheets. IDEAS uses the Cut, Copy, and Paste commands just like other programs. 

The user can see the contents of the Clipboard with the Show Clipboard command in the Edit menu. 

When copying and pasting objects within IDEAS, the Clipboard also holds object parameters and 

connections. This procedure allows the user to paste portions of the models, including the variables in the 

dialog box, to another section of the model, to other models. If the Clipboard has objects in it when moving 

to another application, the contents of the Clipboard are available as pictures (stored in a graphics format). 

This feature is useful if the user wants to show parts of the model in reports or presentations. When 

pasting a picture (PICT objects or bitmapped) from other programs into IDEAS, it becomes a drawing 

object, which can be resized and repositioned. 

If the plotter is the active window, the Copy command puts a picture of the plot in the Clipboard. The user 

can copy data from a plotter’s table by selecting the data and choosing the Copy command. In this case, 

IDEAS puts the data into the Clipboard in text format. Similarly, the user can copy text from dialog boxes 

by selecting it and using the Copy command. Note, that the user can select data from tables and copy it to 

other applications such as spreadsheets–this option makes it very easy to export data to other 

applications. 

The user can copy pictures into IDEAS in color or black-and-white to use in the model windows, 

hierarchical windows, or in the icon in an object’s structure window. The user can create the picture in a 

painting or drawing program such as CorelDraw or Paintbrush and copy it to the Clipboard. Then paste it 

into an IDEAS window with the Paste Picture command from the Edit menu. Pictures copied into IDEAS - 

as objects created with IDEAS drawing tools - always go behind IDEAS objects and text. 

 



 

IDEAS™ v6.5.0 Page 21 of 58 
 

3.5 SCREEN CAPTURES 

To copy parts of a model such as the entire plotter window or a dialog box, use a screen capture program 

to save the selection in a graphics file. Some screen capture programs will save just a portion of the 

screen. 

3.6 INTER-PROCESS COMMUNICATION 

The means by which applications communicate with each other and share data are collectively known as 

inter-process communications. Some communication methods have previously been discussed in this 

manual. For example, the clipboard provides convenient data sharing between applications running on the 

same operating system. The following section focuses on more extensive communication methods that 

allow IDEAS to directly communicate with other applications while the simulation is running. This allows 

IDEAS to work in conjunction with other applications on a wide variety of tasks. 

Inter-Process Communication (IPC) provides a standard way in which one application can directly 

communicate with another. In IDEAS, the user can incorporate IPC into the models using objects from the 

DDE library, using the Hot Link or Publish and Subscribe features (discussed later in this section) or, if the 

user programs, using the IPC functions. 

Communicating applications are typically categorized as clients or servers. A client application requests a 

service from some other application and a server application responds to the client’s request. Many 

applications, such as IDEAS, act as either a client or a server depending on the circumstances. 

As a client application, IDEAS can request data and services from a server application. It does this using 

the IPC library or the IPC ModL functions. 

The IPC functions are implemented using DDE messages (for example, DDEAdvise, DDEPoke, 

DDERequest, and DDEExecute). 

As a server application, IDEAS can receive and execute ModL code that is sent from a client application. 

This means that other applications can instruct IDEAS to perform any task supported by the ModL 

language. 

IDEAS supports the DDEAdvise, DDEExecute, DDEPoke and DDERequest messages. These messages 

accept two string parameters: item and topic. The topic parameter is the name of the IDEAS model 

worksheet with which the user wishes to communicate. The item parameter for DDEExecute contains the 

ModL code to be executed. The item parameter for DDEPoke and DDERequest take the form: "variable 

name:object number:row:column." Variable name can be the name of a dialog item, global variable, or 

static variable. Row and column are zero if the dialog item is not a table. 

For IDEAS to communicate with another application on Windows, the other application must also support DDE. 
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Whether the user uses the IPC library or program using the IPC functions, the IPC client/server 

functionality in IDEAS is cross-platform compatible - the only difference between platforms is in how IPC is 

implemented. On Windows, IPC is supported through DDE and Hot Links. 

3.7 HOT LINKS 

One way to share data between IDEAS and another program is by creating a hot link between the two 

applications. A hot link is a dynamic, one-directional, communication channel. With a hot link, when the 

user changes data in one application, the data in the other application is automatically updated. The user 

can create links between IDEAS and any other application that supports hot links.  

There are two types of hot links within IDEAS:  

1. Links that import data from another application into the model  

2. Links that export data from the model to another application. 

3.8 LINKING DATA FROM ANOTHER APPLICATION INTO IDEAS 

The user may wish to use data from another application as input parameters for objects in the model. To 

do this, create a dynamic link between the data and any parameter field or data table in any of IDEAS’ 

object dialogs as follows: 

In the server application, copy the data to the clipboard using the other application’s Copy command. In 

IDEAS, select the parameter field to which the user wishes to copy the data. 

Note: If the user is copying to a data table, the entire range of cells that need to be linked must 

be selected. 

If the server application supports hot links, IDEAS will recognize it and the Paste Link command in the Edit 

menu will be enabled. Give the Paste Link command to link the data into IDEAS. If a hot link has been 

successfully created, the parameter will have a border around it. Once a hot link has been created, any 

changes made to the data in the other application will immediately be reflected in IDEAS. To remove the 

link, select the parameter and choose Delete Link from the Edit menu. 

3.9 LINKING DATA FROM IDEAS INTO ANOTHER APPLICATION 

The user may decide to export data from the model to another application for further analysis or presentation. 

To create a hot link that does this: In IDEAS, select the object dialog parameter or data table cells that are 

to be linked. Select Copy from the Edit menu. 

Refer to the other application’s documentation to determine the way in which a hot link is created. 

Typically, one would choose Paste Link or Paste Special from the client application’s Edit menu. 
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When a hot link is created, the parameter in IDEAS will have a border around it as shown in the 

Section 3.7. Any changes made to the parameter in IDEAS is reflected in the other application. To remove 

the link, refer to the other application’s documentation. 

All hot links are saved with the IDEAS model. When the model is opened, IDEAS attempts to reestablish 

the associated links. 

3.10 SERIAL PORTS 

Please call IDEAS Customer Support (see Section 5) if the user need to interface the model through the 

serial port. 

3.11 OTHER DEVICES, EXTERNAL CODE SEGMENTS, AND DLLs 

Please call IDEAS Customer Support (see Section 5) if the user needs to interface the model with outside 

hardware devices or to run external code resources. 

3.12 COPYING PLOTTED INFORMATION 

The user can copy the information from the plotter to the Clipboard. If the plotter is the front-most Window, 

simply choose Copy Plot from the Edit menu to copy the picture of the plot into the Clipboard. To copy the 

data, the user must select it, and then choose the Copy command. 
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3.13 TOOLBAR 

The tools in the toolbar at the top of the screen are used when interacting with the model window. The 

tools available when a worksheet is active are: 

 

Figure 10: Tools in the Toolbar 

3.13.1 FILES 

The first group is a standard set of buttons that deal with files. The user opens a new model worksheet by 

clicking on the New model worksheet button. The Open button will open existing worksheets or text files. 

The Save and Print buttons respectively save and print the active worksheet or text file. 

3.13.2 EDITING 

The second group is a standard set of buttons for editing. The Cut and Copy buttons respectively cut and 

copy the current selection. The Paste button will paste the contents of the clipboard into the active 

window. Use the Undo button to reverse the previous action. Clicking the Undo button a second time will 

redo the action. 

3.13.3 MODELS 

The next two buttons deal with the model in the active worksheet. The Open notebook tool is used to open 

the model’s notebook. Clicking the Run simulation tool will start the simulation. 
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Although the model worksheet appears to be flat, it is actually composed of several layers, which hold 

items such as objects, text, pictures, and so on. The first three tools in this group (Main cursor, Draw layer, 

and Clone layer) let the user select model or Notebook items (objects, drawing objects, or cloned dialog 

items) in specific layers. The All layer tool selects all items on the worksheet or Notebook. Since the user 

probably would use the Main Cursor or object/text layer tool most of the time, it is the default tool. 

The specific selection tools are especially useful for selecting an item if both types of items are near each 

other in the model. For example, if the user has a drawing item behind an object and the user wants to 

move just the drawing item, use the Draw layer tool. The tools are also helpful when the user wants to 

choose what to copy. For instance, to copy the entire model worksheet, including drawing objects and 

cloned dialog items, use the All layers tool. To copy only specific objects, use the tool for that type of 

object. Tools usage is described in more detail later in this section, along with the types of objects they 

manipulate. 

When windows other than the model window are active, the Main cursor or Block/Text layer tool is still the 

default tool, but changes its behavior to accommodate the most typical use. For example, when a 

Notebook is open, the default tool allows the user to select drawing items as well as text. 

3.13.4 ZOOM 

 

Figure 11: Zoom Window 

3.13.4.1 Normal Size 

Enlarges a previously reduced model to its original size. IDEAS displays a rectangle. Click and drag this 

rectangle to the desired view. When the mouse button is released, the view is expanded. 

3.13.4.2 Reduce to Fit 

Scales the model so that it fits in the active window. Use this command instead of using the Reduce 

command multiple times for multiple worksheets. 
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3.13.4.3 Reduce 

Scales the image of the model by half. Use the Expand command or Normal Size command to reverse the 

action of this command. The Reduce command is useful if the model is too large to fit on the screen. 

Reduce can be chosen several times to display a large model at a reduced scale. 

3.13.4.4 Expand 

Doubles the size of the model. This command works the opposite of the Reduce command. IDEAS 

displays a rectangle. Click and drag this rectangle to the desired view. When the mouse button is 

released, the view is expanded. 

3.13.5 PATTERNS AND COLORS 

Every drawing object has both a pattern and a color chosen from the menu in the toolbar (text can have 

color but not a pattern). The default is solid pattern and black color. Click on the Pattern or Color icon to 

open the window. For example, the patterns are: 

 

Figure 12: Pattern Palette Window 

In these choices, black gives a solid pattern, white gives an opaque white pattern, and the "N" signifies no 

pattern, meaning transparent. 

The Pattern palette window can be positioned anywhere on the screen by clicking on the top of the 

window and dragging it to the desired location. To close the window, click on the close box in the upper 

left-hand corner. 

The color tools work similarly to the pattern tools. When the user clicks on the Color icon, the Color palette 

window opens. The user can type text in color or add color to text by selecting the text and choosing a 

color from the color tools. As seen with formatting text, if the user changes the color before starting a text 

box, all new text will be in that color. 
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Figure 13: Color Palette 

Notice that when a color is selected the hue, saturation, and brightness (value), or HSV, settings for the 

color are listed at the bottom of the color palette window. This is helpful when the user needs to know the 

HSV settings for a given color. 

The next tool is the Text tool. Use the Text tool to add text to the model, such as descriptive labels or 

names for named connections. 

3.13.6 WORKING WITH THE TEXT BOX 

To add text to the model, select the Text tool, click on the model where the user wants to add text (or just 

double-click in the model window with any one of the layer tools) to start a text box; then type in the 

required text.  

To stop entering text, press the Enter key (located on the numeric keypad) or click anywhere else in the 

model window. The user can access the text box after having stopped typing either by selecting the Text 

tool and clicking once on the text that has already been typed or by selecting the Block/Text or All layers 

tool and double-clicking on the text. 

As the user types, the text box can be seen as a gray box with four handles. Select the Text tool. Now, 

click above the object on the left and type "Three polluters". 

 

Figure 14: Text Box 

Before pressing Enter on the numeric keypad or clicking elsewhere, click and drag on a handle to change 

the size and shape of the text box. For example, to make the box narrower and taller, put the cursor over a 

handle. When the cursor changes shape to a two-headed arrow, drag it left and down. 
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Figure 15: Reshaping Text Box 

Moving text around the model is easy. Before pressing Enter to finish entering text, the user can move the 

text by moving the mouse pointer to the border of the text box away from the handle so that it turns into a 

hand. Then click and drag the text box to the desired location: 

 

Figure 16: Moving Text Before Pressing Enter 

If the text has already been entered, simply move the cursor over the text so that it becomes a hand; now 

drag the text to the desired location. 

To copy the entire contents of a text box to a model window, click once on the text box to select it and 

choose Copy from the toolbar or give the Copy command from the Edit menu. Then click on the model 

window where the user wants to place the text and give the Paste command. To copy all or a portion of 

the text in a text box and paste it into another text box or onto the model worksheet, double-click the text 

box (or click once using the Text tool) and select the text to copy. Then double-click to create or open a 

text box and paste the text. 

Note: When text is pasted onto the model worksheet or into another text box, it remains as editable text. 

However, if the user selects and copies an entire text box and pastes it to the Notebook, it 

becomes a picture. To paste editable text into a Notebook, copy the contents of the text box, 

not the text box itself. 

The user can delete text by:  

1. Selecting it with the cursor and pressing the Delete key 

2. Choosing Clear from the Edit menu 

3. Choosing Cut from the tool bar. 

The user can also add formatting to text. To format existing text, access the text box, select the text, and 

then choose a command from the Text menu, e.g., Bold or Align Center. The user can also change the 

color of the text as described earlier. 

Note: If the user wants to type new text with a particular format, select the desired format before starting 

the text box. IDEAS will remember that format every time a new text is started. However, if the 

user changes the format of the text within an existing text box, IDEAS will not use that format on 

the next new text. 
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3.13.7 DRAG AND DROP EDITING 

IDEAS supports a text editing feature called drag and drop. Drag and drop is the easiest way to move a 

selection of text a short distance or between documents. This feature is an alternative to the Cut, Copy, 

and Paste commands. 

To move text using drag and drop editing: Select the text to move. 

Point the selected text and hold down the mouse button. When the user drags the selection, an insertion 

point will appear to the left of the cursor. Drag the insertion point to the desired location and release the 

mouse button. 

To copy text using drag and drop editing: 

Select the text to copy. Hold down the Alt key, point to the selected text, and then hold down the mouse 

button while the user drags the insertion point to the new location. Release the mouse button. 

Drag and drop can be used within a text box on a worksheet, a text file, an object’s structure window and 

between any combination of the above with one exception: drag and drop will not work between two 

separate text boxes. For example, if the user double-clicks on the worksheet to open a text box, enter text 

into the text box, then select a portion of the text, the user will not be able to move that text to another text 

box using drag and drop. This is because, on the model worksheet, there can be only one text box open 

for editing at a time. However, the user can drag the text to a text file window or an object’s structure 

window. 

3.13.8 DRAWING 

The next seven tools are used to add drawing objects to the model and arrange them in layers. These 

tools are used to make the models easier to read or to make them more aesthetically pleasing. 

The Rectangle, Rounded Rectangle, Oval, and Polygon tools add those shapes to the worksheet or 

Notebook. For example, to add a rectangle, select the Rectangle tool, click in the model where the user 

wants one of the rectangle’s corners, and drag to the diagonally opposite corner. Similarly, the Line tools 

can be used to draw lines on the model. The Line tool draws a line at any angle and the Draw right angle 

line tool restricts the lines to horizontal and vertical lines. The user can also add colors and patterns to the 

shapes and lines drawn, as described earlier. 

If the user holds down the Shift key as the rectangle, rounded rectangle, or oval shapes are re-shaped, the 

shape becomes a square or a circle. If the user resizes a square or circle while holding down the Shift key, 

it maintains its proportional measurements. 

The Shuffle graphics tool lets the user arrange drawing objects (not text) that are on top of each other. 

Click on this tool, and then click its crosshairs on the object in the window. If the object is in front, it will be 

sent behind. If it is not in front, it will be brought to the front. Blocks, text, and cloned dialog items 

(described below) are always in front of any drawing item and therefore cannot be shuffled. 
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To see how the color and drawing tools work, select the Oval tool and draw an oval behind the model. 

Note that, it comes out black and the text and icons come out on top of the oval automatically. Choose a 

new pattern for the oval from the Pattern tools, such as the striped pattern. Try changing the oval’s color 

as well. 

3.13.9 CLONING DIALOG BOX ITEMS ONTO THE WORKSHEET 

This feature can be helpful in dragging dialog box information such as flow and temperature values onto 

the worksheet above the pipe or transmitter with which it is associated. Cloning allows the user to view this 

live data directly from the worksheet or notebook without having to open the dialog box. In very large 

models, having all the choices in dialog boxes can be a disadvantage. The user may want easy access to 

parameters in several objects that are scattered throughout the model. IDEAS takes care of this problem 

by giving the user the freedom to clone dialog box items and place them in a more convenient location. 

The user can clone an item to more than one location. For example, the user might want a clone in two 

parts of the model window. Every clone acts exactly like the original: if the user changes the original or any 

clone, all instances are updated immediately. 

Cloning dialog box items onto the worksheet provides direct control of the model. The user can use the 

dialog box items as the simulation runs, such as clicking buttons or entering values in text entry boxes. For 

instance, the user may have a model with objects that have controls in them that can be varied as the 

simulation is running. Instead of having those controls in a dialog box, the user can put them out on the 

model window. Alternatively, the user might want to have an area of the model that shows displays in a 

numeric form instead of the graphical form of the plotter. 

To clone a dialog box item: 

1. Open the desired dialog box 

2. Select the dialog clone tool 

3. Clone the variable window in the dialog box 

4. Drag it onto the appropriate spot on the worksheet 

Now, the user can watch the live data during the simulation without having to open the object dialog box. 

For multiple items, select by dragging a frame or holding down the Shift key when selecting more items. 

Then close the dialog box by clicking the close box or choosing the Close command from the File menu. 

Multiple copies of a clone can be made by cloning from the dialog box again or making a clone of another 

clone. Always make sure Show Animation is checked under the Run menu. 

To change a value at a point in the simulation, click on the number in the cloned field and type a new 

value. IDEAS pauses so that the user can type the value. Click the Resume button in the status bar at the 

bottom of the screen and the simulation continues with the new value. 
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The user can also clone from a dialog box within a hierarchical object to the hierarchical object’s window 

or the main worksheet. To do this, open the hierarchical object’s window. Open the object dialog box and 

choose the dialog clone tool, click on the desired item, and drag it to the desired location. 

Once a cloned item is on the worksheet, it can be dragged anywhere. Many people prefer to have all the 

items together at one end of the model. (Notebooks are useful in this circumstance.) To move a cloned 

item, choose the dialog clone tool from the toolbar, click on the item, and drag it. 

Note: The graphs and data tables in plotters can also be cloned just like buttons and text entry boxes. 

To size a cloned item, select the clone tool and click on the cloned item once. A handle appears in each 

corner–click and drag a handle to the desired size. To identify the dialog box from which an item was 

cloned, choose the dialog clone tool and double-click on the item. 

To remove cloned items from the model, simply select them (using the dialog clone tool) and press the 

Delete key or choose Clear from the Edit menu. If the original object from which a dialog box item was 

cloned is deleted from the worksheet, all clones of this item are automatically deleted. 

3.14 LIBRARIES AND OBJECTS 

Each object is represented by a unique icon that shows how that object relates to other objects in the 

model. Information comes into the object and is processed by the program that is in the object. Then the 

object transmits information out of it to the next object in the simulation. 

Objects are stored in libraries. Because the worksheet only contains references to objects stored in 

libraries, the libraries must be present for the worksheet to run. There are many advantages to this method 

of using references to libraries instead of actual objects in models. If the definition of an object in a library 

is changed, all models that use that object are automatically updated. Also, object definitions are quite 

large, and storing just a reference to the library saves a great deal of disk space and memory (RAM). The 

entire definition for an object (its program, icon, dialog box, and so on) is stored in the library. IDEAS also 

stores the data that the user enters in the object’s dialog box in the model. 

There are two ways to open a library. IDEAS will automatically open all libraries associated with a model 

when the model is opened. This option is controlled in the program Options (in the Edit menu) dialog box 

by selecting the option Automatically Open Libraries. The user can also open a library by choosing Open 

Library from the Library menu. Once a library is open, the library name appears at the bottom of the 

Library menu. To see a list of objects in a library, select the library name in the Library menu and an 

alphabetical menu that contains a list of all the objects in the library appears next to the library name. 

Selecting an object in this list will add the object to the model. 

Choose "Open" to locate and open another library where the object no longer exists in that location, or if 

another object cannot be substituted (as discussed below). In this case, IDEAS notifies the user that it will 

place text in the place of the object. 
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Figure 17: Warning Message when Object not Found 

Choose "Substitute" to select an alternative object from a library. A dialog box opens: 

 

Figure 18: Substitute Object Dialog Box 

Open libraries are listed on the left side of this dialog box; the objects in the selected open library are listed 

on the right. Use the dialog box to locate and select the object to substitute. The user can select an object 

from an open library, "Open" a library, or "Cancel" the search operation. Once an object is selected, 

choose "Substitute" and IDEAS will try to use that object in the model. (Any substituted object must be 

substantially the same as the object searched for, or IDEAS will report error messages). If the search is 

canceled, IDEAS will notify the user that it will place text in the place of the object (as mentioned above). 

When the model file is subsequently saved, any new object name and/or location will be saved as well, so 

searching will not be necessary the next time the model file is loaded. 
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If an open library contains an object with the same name as the object searched for, IDEAS will attempt to 

use that object rather than search for the original library. When building new objects (hierarchical objects), 

do not use duplicate names for objects. 

3.14.1 CHANGING LIBRARIES 

If the "Automatic Library Search" option in the Options dialog box of the Edit menu is checked, IDEAS 

automatically opens the libraries that a model uses. However, sometimes the user may want to use 

objects from a different library (for example, when a new version of the library has been developed). 

To bypass this process, unselect the "Automatic Library Search" option. If this option is unselected before 

opening a model, IDEAS will stop and request the location of each library used in the model. Then use the 

dialog box to find and open the desired libraries to be used in the model. 

Once all of the required libraries are open, save the model. The next time the model is opened, it will 

automatically locate and open the libraries in the new location. Remember to reselect the "Automatic 

Library Search" option in the Options dialog box before reopening the model. 
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Figure 19: Library Window 

3.14.2 LIBRARY WINDOWS 

The first choice in the objects list for each library in the Library menu is Open Library Window. When this 

command is selected, IDEAS opens a library window for that library. 

The top of the library window gives information about the library version, size, and date last modified. The 

objects in the library are listed with pictures of their icons and their last modified date. 
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The primary method for adding objects to a model is by using the alphabetical menus in the Library menu. 

The library windows provide an alternative method for adding objects to models and help maintain the 

libraries (as discussed below). When using the Developers Kit to program objects, the library window can 

be used to access an object’s structure. 

To add an object to a model using the library window, first position the windows so that they are side by 

side (not overlapping). Then select the object in the library window and drag it onto the worksheet. Select 

many objects at once by holding down the Shift key as they are selected, then drag them all at once to the 

worksheet. 

To close the library window, click on the window’s close box or choose the Close command from the File menu. 

Note: This closes the library window but not the library. 

3.14.3 MAINTAINING OBJECTS IN LIBRARIES 

Note: This section is meant only for use on user-created hierarchical or Developer Kit objects, not on 

IDEAS core library objects. Changes made to these core objects may result in numerous errors. If 

any of these errors occur, call Tech. Support immediately. 

IDEAS makes it easy to handle objects using the library windows. For example, to copy an object from 

one library to another, simply drag that object from its library window to the destination library window. 

To make a copy of an object in the same library, select the object in the library window and choose 

Duplicate from the Edit menu. The Duplicate command copies the object into the current library and 

renames it with the object name followed by the word "Copy." This process is common if the script in one 

object is needed as the template for a different object, or when two objects perform the same actions but 

need different icons. 

To change the name of an object (NOT CORE LIBRARY OBJECTS), select the object in the library 

window and choose Rename Object from the Define menu, then type in the new name. If the name of an 

object is changed, models that use that object will not be able to find it because they are expecting the 

original name. IDEAS then asks for object location and opens a search dialog box, as discussed in "Object 

searches." Use this search procedure to locate and substitute the renamed object. When the model is 

saved, IDEAS will save the new name so it will not prompt for the object when the model is opened again. 

To remove an object from a library, select the object in the library window and choose Clear Objects from 

the Edit menu or press the Backspace key. IDEAS will not allow the removal of an object that is in use in 

an open model window. If an object used by a model is removed, and the model is opened later, IDEAS 

warns the user and put a placeholder in the model window. 



 

IDEAS™ v6.5.0 Page 36 of 58 
 

On very rare occasions, a message appears as a library is opened that indicates that an object has been 

corrupted or is bad. The corrupted object will appear in the library listing as "*BAD*Blockname." To save the 

rest of the library, copy the uncorrupted objects to a new library and discard the old library. Then copy the 

backup copy of the object into this new library (this is another good reason to always back up one’s work!). 

3.14.4 ORGANIZING LIBRARIES 

ANDRITZ Inc. strongly suggests that any new objects created (either hierarchical or with the Developers 

Kit) be stored in separate libraries created by the user. Do NOT put these objects into the Standard 

Libraries created by IDEAS. This arrangement would cause problems when updating libraries. Also, 

creating new libraries aids users in identifying and structuring their own developments. For example, 

worksheet-specific, user-specific, or project-specific libraries are good divisions. The user may want to 

copy core objects (those created by IDEAS) into these newly created libraries for easy access while 

building worksheets. 

3.15 BUILDING A MODEL 

This section describes the steps in modifying or creating a model from the libraries that come with IDEAS. 

3.15.1 ADDING OBJECTS 

The four steps to add objects to a model are: 

1. Open the library, if necessary. 

2. Place the object on the worksheet. 

3. Move it to the desired position. 

4. Connect it to objects before and after it in the model. 

As stated earlier, the models do not actually contain objects. Instead, the model holds references to 

objects that are in libraries. In the model, the object’s dialog box appears after double-clicking on the 

object’s icon. 

To copy an object into a model, the library in which that object resides must be open. 

3.15.2 OPENING THE LIBRARIES 

To copy an object into a model, the library in which that object resides must be open. 

1. To open the library: 

2. Choose Open Library from the Library menu. 

3. In the File Open dialog box, locate and select the library. 

4. Click Open to open the library. 
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3.15.3 PLACING AN OBJECT ON THE WORKSHEET 

To place an object: 

1. Click in the Library menu. 

2. Drag down to the name of the library that holds the desired object. When the library is selected, the 

names of all the objects in the library appear in an alphabetical menu to the right. 

3. Drag to the right and then down the list until the desired object is highlighted. Let go of the mouse button. 

4. This places a copy of the object in the upper left-hand corner of the window and selects it. 

3.15.4 MOVING OBJECTS 

To move an object, click on the object and drag it with the mouse. When the cursor is over an object, it 

turns to a drag hand. Click on the object, drag it to the desired position, and let go. 

3.15.5 CONNECTING OBJECTS 

Connectors are used to hook objects in the model together. Connectors are linked by connections, the 

lines seen between the objects in the model window. For more information, see the Connectors and 

Connections section. 

3.15.6 DELETING OBJECTS 

Removing objects from a model is easy. Simply click on the object to select it and press the Delete or 

Backspace key. Like other applications, selecting something and pressing Delete or Backspace removes it 

from the worksheet. In this case, IDEAS removes the object and all input and output connections to the 

object. The objects can also be cut using the "Cut" command from the Edit menu. 

3.15.7 CLOSING LIBRARIES 

To close a library, choose Close Library from the Library menu and select the library to be closed. 

3.15.8 DIALOG BOXES 

Dialog boxes are pop-up windows behind every object. They are accessed by double-clicking on the 

object’s icon with the mouse. The dialog box is the user interface to each object. It serves two main 

purposes: 

1. Enter process or equipment information specific to the object to customize a generic valve, pump, 

tank, etc., in the library with specific conditions in order to run a particular simulation. 

2. Display information about the object as the simulation runs either instantaneously or on demand. For 

example, a flow transmitter would display flow in the dialog box. 

Click on the Help button at the bottom left-hand corner of the dialog box to get more information about the 

object. Click Cancel to close the dialog box and discard any changes made. Clicking OK or the close box 

at the upper left-hand corner of the dialog box will save the changes. 
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3.16 HIERARCHY 

So far, each object described performs an action that is one part of the model. The action that the object 

performs is represented by the object’s icon. Most IDEAS objects work this way. There is a second type of 

object—a hierarchical object—that works differently. A hierarchical object acts like a container that holds 

other objects. A hierarchical object may contain simple objects, other hierarchical objects, or both. The 

objects in a hierarchical object are connected just like other objects in a model, and hierarchical objects 

have input and output connectors like regular objects. 

Although not needed to build models, there are many uses for hierarchical objects: 

 Create advanced objects using a combination of simple, core objects 

 Simplify the worksheet by grouping areas of a complex model. These grouped objects can then be 

reused in other models without having to reproduce all of the connections. 

 Present a model as a few simple steps. To reveal the subsystems within a step, just double-click on 

the hierarchical object. 

 Create many levels of hierarchy. Beginning with the simplest assumptions and proceeding to more 

complex ones allows the user to structure interconnecting processes and make models easier to 

follow. 

3.16.1 OPENING HIERARCHICAL OBJECTS 

As demonstrated below, the Heater/Boiling object from the HEAT EXCHANGERS library is a hierarchical 

object: 

 

Figure 20: Heater/Boiling Hierarchical Object 

It contains Temperature-Transmitter objects (ANALOG CONTROLS library), a Pipe w/Heat Exchange 

object (HEAT EXCHANGERS library), and Tank/Multiphase (TANKS - DYNAMIC library). When the user 

double-clicks on the object, the following window opens: 
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Figure 21: Heater/Boiling H-Block 

3.16.2 INTERNAL STRUCTURE OF HEATER/BOILING OBJECT 

It should be noted that the hierarchical object itself is only a picture representation of this window. 

Connections seen here are linked to other objects on the main worksheet. These connections are 

represented by text boxes (named connections with borders around them). 

Changes can be made in these objects just as in objects on the model worksheet. Open the hierarchical 

object and double-click on the desired icon to change its settings. Dialog box items from these objects can 

also be cloned as discussed previously in the Cloning section. 

3.16.3 PRINTING HIERARCHICAL OBJECTS 

IDEAS allows the user to control the number of levels of hierarchy to be printed. Please see the Print 

section at the end of this section for more information. 

3.16.4 CREATING A HIERARCHICAL OBJECT 

Please see Appendix C for detailed instructions on how to create hierarchical objects. 
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3.17 PLOTTERS 

Most of the IDEAS plotters have many features in common. This section describes IDEAS plotter dialog 

boxes and how to customize plots. 

Up to four (4) traces can be plotted at a time. Plotters can only be connected to scalar connectors (refer to 

the next section (Connectors and Connections). Therefore, a transmitter needs to be on the worksheet 

when using a plotter. More than one plotter can be used on a worksheet, and they can be placed at any 

point on the model. The choice of plotter types depends on how the user wants information plotted. See 

Plotters help text for details on different plotter types and the plotter tool bar. 

Each plotter that opens during a simulation stores the plots from the last four (4) runs. When a plotter’s 

icon is opened, a plot from the most recent run is seen. 

 

Figure 22: Plotter I/O Window 

The plotter window has two panes. The upper pane shows the plot (a series of traces) and the lower pane 

shows the data for that plot. Most of the time, the user is interested in seeing the plot; however, the data 

pane is also quite valuable. The two panes are separated by a split bar. About two thirds of the window is 

devoted to the plot and one third to the data. This can be changed by moving the cursor over the split bar 

until it changes to a double arrow. Then click, hold, and drag the double arrow up or down to resize. 
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3.17.1 PLOT PANE 

The plot pane has four pages. If the plotter is open during the simulation run, the four most recent runs will 

be saved on those pages. If the plotter is not open during the simulation run, only the current plot image is 

saved in the plot pane. Each page can be seen by clicking on the number at the lower left of the plot pane. 

When looking at the data, the user may want to see the exact numbers that generated a point. Although 

the user can scroll in the data pane, IDEAS provides a faster method. Place the cursor over the desired 

point on the plot line; the top row in the data pane contains the value that matches that point. 

To change the plot labels and axis limits directly in the plot pane, click on the item to be changed and type 

the new text. To finish, press Enter or click somewhere else in the window. To change many of the labels 

and limits, press Tab after entering the new values. When using the Tab method to change items, the plot 

will redraw only after pressing Enter or clicking in the window. 

3.17.2 DATA PANE 

When the data in the data pane is changed, those changes are reflected in the plot. Numbers can be 

changed; rows can be inserted by pasting, and so on. Use this capability to view how various data would 

be plotted or to plot a reference line. 

3.17.3 PLOTTER TOOLS 

Note the tools at the top of the plot pane. These are used to change the traces and views for the plots and 

to change the labels and formatting for the data being plotted. Tools with arrows beneath them have 

multiple choices. Click on a tool to activate it. The toolbar in plotter windows looks like the following: 

 

Figure 23: Plotter Toolbar 

For complete information on the functions of each tool, see the Plotters help text. 

3.18 CONNECTORS AND CONNECTIONS 

The small squares attached to each side of the object are called connectors. Information flows into an 

object at input connectors and out of the object at output connectors. An object might have multiple input 

and/or output connectors, and some objects have none. Connecting lines are used to link objects together. 

These lines (called connections) show the flow of information from object to object through the model. 

Major equipment objects are typically connected with piping objects. When these connections are made 

with the mouse, all subroutine links are made and parameters passed transparent to the user. In fact, 

flowing through the pipe is an array of up to 40 components with their associated properties and process 

conditions. 
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There are several types of connectors in IDEAS. Many objects use value (scalar) input and output 

connectors to pass values: 

 

Figure 24: Scalar Input and Output Connectors 

These connectors pass single values and are most commonly used for control signals, transmitter outputs, etc. 

The actual process streams (flow through pipes), which consist of arrays of numbers, use stream array 

input and output connectors: 

 

Figure 25: Stream Array Input and Output Connectors 

The method of passing these arrays is part of the IDEAS proprietary methodology, and therefore 

non-IDEAS objects will not successfully communicate through these connectors. All objects using the 

scalar connectors will directly connect to scalar connectors on IDEAS or any other object using scalar 

connectors (Stream array objects can be created using IDEAS Developers Kit). 

IDEAS ensures that correct connections are made. For example, if the user tries to connect a stream array 

output to a scalar input, IDEAS will provide an error dialog message. 

To connect an output connector on object A to the input connector on object B: 

Move the cursor to the output connector of object A. The cursor changes from an arrow to a technical 

drawing pen [ ]. 

Click and hold down the mouse button in the output connector, then drag the line to the input connector on 

object B. The line becomes thicker when the pen is over the connector. 

Let go of the mouse button. 

A dashed line indicates an incomplete connection. To erase the faulty connection, click on the line so that 

it thickens (indicating that it has been selected). Press the Delete or Backspace key. When using lines with 

anchor points, a single-click will select only that branch of the line, while double-clicking the line selects 

the entire line. 
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3.19 CHANGING CONNECTION CHARACTERISTICS 

The lines that make up connections can be formatted to make the model layout clearer. The Connection 

Lines command from the Model menu changes the line style of the connections. To use the command, 

select the desired connections and choose an option from the hierarchical menu: 

 

Figure 26: Connection Line Styles 

3.19.1 CONNECTION LINES COMMAND 

The top option allows the user to choose diagonal or right angle connections. The right-angle option will 

make the selected connection into a three-part connection with anchor points. The default type of line can 

be specified in the Options command from the Edit menu. 

The second connection line choice provides arrows on the connections. Arrows can only be used with 

right-angle connections, and the direction of the arrowhead follows the direction the line was drawn when 

the connection was made. 

The connection lines can be thin, medium, thick or double lines based on the option selected. IDEAS 

normally uses thin lines for clarity, but thick lines may be used to highlight important connections. The 

fourth choice allows right angle connections appear as solid lines or dotted lines. 

3.19.2 WAYS OF CONNECTING OBJECTS 

There are three ways to make connections between objects: 

Use a direct connector as shown below. Delete this connection by clicking on it and pressing the Delete or 

Backspace key.  
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Use a right-angle connector as shown below: 

 

Figure 27: Right Angle Connection 

Use an anchor point. Draw a connection from the connector to a point below it, then release the mouse 

button. Make sure that the cursor still looks like a technical pen; immediately click again and drag to the 

desired connector. Release the mouse button when the line thickens. The result will look something like: 

 

Figure 28: Connection through an Anchor Point 

Use a named connection. Named connections are text labels that are used to represent transparent 

connections in the model. Double-click near the connector to obtain a text box. Type a name for the 

connection. Repeat this procedure at the desired destination connector using the same label (or simply 

copy and paste the text box). In named connections, the user must use identical spelling in the text names 

(including spaces). Connect the text box with the technical pen tool to the corresponding connector. To 

see the connection, choose Show Named Connections from the Model menu. 
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Figure 29: Connection using Named Connection 

3.20 RUNNING THE MODEL 

3.20.1 SIMULATION SETUP 

The Simulation Setup dialog box specifies how the simulation will run and for how long. The dialog box 

looks like: 

 

Figure 30: Setting Up Simulation 
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3.20.2 SIMULATION SETUP DIALOG BOX 

Note: Always select Left to Right for Simulation Order when running dynamic simulations. In steady state 

(Macro) models, switching to the Flow Order may improve the speed at which convergence is 

reached. The user may want to experiment with the simulation order for a given Macro worksheet. 

Each time a simulation is run, IDEAS uses the same values entered in the Simulation Setup dialog box 

from the Run menu. 

Generally, the only setting to be changed in the dialog box is the end time. For most purposes, the 

simulation should start at the beginning, so the default start time would be 0. Also, most continuous 

simulations use a time per step (dt) of 1. Change the Number of runs option to repeat the simulation and 

to look at how results change over many runs. 

3.20.3 SIMULATION STATUS 

The choices in the Status bar at the bottom of the screen are based on the settings in the Simulation 

Setup dialog box. 

 

Figure 31: IDEAS Status Bar 

The numbers after the hourglass are an estimate of the time remaining in the simulation, so the user can 

determine how long it will run. The clock shows the current time of the simulation in time steps. "Run" is 

the number of the simulation, if running multiple simulations. These values are determined by the entries 

in the Simulation Setup dialog box. 

Note: The time remaining shown in the status bar is only an estimate. To pause, click the Pause button 

on Tool bar (and not the Stop button). This button then turns to Resume for continuing the run. 

The simulation can also be stopped and paused from the Run menu. 

3.21 SENSITIVITY ANALYSIS 

Sensitivity analysis allows the user to conduct experiments and investigate the effects of changes in a 

structured, controlled manner. The user does this by running simulations many times, changing the value 

of a variable or numeric parameter each time the simulation is run. When the user repeatedly runs a 

simulation that has parameters that vary with each run, the user can see the range of the results and look 

for trends or anomalies. For example, if the user runs the same simulation a hundred times, the user can 

look for extremes in results and look for averages of critical values. 

IDEAS’ sensitivity analysis feature gives the user the ability to explicitly specify individual parameters to 

change and provides several methods for changing them. 
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Sensitivity analysis differs from using random numbers as inputs in the model. When the user runs a 

model and uses a random input, a random number will be input at each step or event. When the user uses 

sensitivity analysis, the randomness occurs from run to run, not between steps in the run. This feature is 

particularly useful when the user wants to investigate how a change in one parameter impacts the pattern 

of behavior for the entire model. 

To use sensitivity analysis in a model: 

 Choose a parameter value to investigate 

 Choose how the parameter will change 

 Select the number of runs for the analysis 

 Run the simulation with Use Sensitivity Analysis selected in the Run menu 

Sensitivity analysis is a very powerful feature that the user can use in models. For complete details, see 

Appendix D, Sensitivity Analysis. 

3.22 MONITORING MODEL OPERATION 

The following sections describe various methods for monitoring the operation of the model using the 

IDEAS simulation package. The first five methods described are available to the user at the IDEAS 

workstation, while the sixth method described is only available when the model is used for training. 

3.22.1 PLOTTERS 

Upon running a simulation, a plotter window automatically opens for each plotter on the worksheet. 

Information is Continuously Updated on the plot, allowing the user to visually monitor the progress and 

possible errors in the model. 

3.22.2 ANIMATION 

For additional feedback as the model runs, IDEAS has animation capabilities. Many of the objects in the 

libraries have animation built into them, such as fluid levels in tanks or color indicators of energy flow. The 

animation in these objects is described in the library manuals. Also, the help text in the dialog box for an 

object tells whether it is animated and, if so, which aspects are animated. 

To see animation, choose Show Animation from the Run menu so that the command is checked, then run 

the simulation. Animation is not shown all the time as it increases simulation time. Animation may be left 

on while changing, debugging, or presenting the model and then turned off when running the model for 

analytical results. Selecting bitmap objects in the Options dialog box speeds up animation and the redraw 

of objects. 

To see the animation without interference from the plotter, plotters can be configured to remain closed 

during simulation runs. (The plotter can be prevented from opening at all during the simulation by choosing 

the dialog tool in the plotter’s tool pane and deselecting Show plotter during simulation. This option can be 

completed manually after the simulation starts by clicking the plotter’s close button). 
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The Show Object Messages command from the Run menu is a type of animation used by programmers 

when they debug objects that they build. 

Note: Animation used extensively will slow down model execution significantly. 

3.22.3 DIALOG BOXES 

Dialog boxes can remain open while the model runs, although it slows down the simulation significantly. 

Settings in a dialog box can be changed while the simulation runs such as choosing different radio buttons 

or typing in new values. When a button is clicked, the object reflects that change on the next step. 

However, when text or numbers are entered into a dialog box field, the model pauses until typing is 

completed. The Resume button at the bottom of the screen can be clicked to continue. 

3.22.4 CLONING DIALOG BOX ITEMS 

Cloning allows the user to view live data directly from the worksheet or notebook without having to open 

the dialog box. 

Note: This feature allows the simulation to run faster than open dialog boxes. Cloning dialog box items 

onto the worksheet provides direct control of the model. The user can use the dialog box items as 

the simulation runs, such as clicking buttons or entering values in text entry boxes. 

To clone a dialog box item: 

 Open the desired dialog box 

 Select the dialog clone tool 

 Clone the variable window in the dialog box 

 Drag it onto the appropriate spot on the worksheet 

Now the user can watch the live data during the simulation without having to open the object dialog box. 

For multiple items, select by dragging a frame or holding down the Shift key when selecting more items. 

Then close the dialog box by clicking the close box or choosing the Close command from the File menu. 

The user can make multiple copies of a clone by cloning from the dialog box again or making a clone of 

another clone. Always make sure Show Animation is checked under the Run menu. For additional 

information on cloning, see the Cloning section earlier in this section. 

3.22.5 USING THE NOTEBOOK 

Each model has a Notebook that can be used for controlling the model parameters, reporting simulation 

results, and documenting the model. This Notebook feature provides more flexibility with cloned dialog box 

items. To have easy access to cloned items, they can be collected in the model’s notebook, producing a 

single data monitoring area. 
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Use the Notebook for both input and output values. For example, the user may want to clone buttons in 

the Notebook and change them as the simulation progresses, or the user might want to use the Notebook 

mostly for looking at the various outputs of the model. Plots can even be cloned into the Notebook. 

Another common use is as a control panel. The Notebook is also handy for combining all of the output into 

one spot for printing or making a screenshot for a report. To create and view the Notebook for a model, 

choose Show Notebook from the Model menu. 

Cloning items into a Notebook on a small screen may be difficult because it is hard to have the model, an 

open dialog box, and the Notebook showing at the same time. If just an edge of the Notebook is visible 

behind a dialog box, however, items can easily be cloned into it. Drag the items to that edge so that the 

item is over the Notebook and let go. Later, the Notebook can be arranged to the user’s particular needs. 

3.22.6 DCS MONITORING 

IDEAS has the ability, through a custom interface, to communicate with a DCS. The model can be set up 

to simulate a mill or plant by responding to outputs from the DCS with inputs that are both analog and 

digital. The simulation computer controls the model simulation, transparent to the operator, just as the 

configuration works transparent to the operator in the actual plant. Once the simulation has been started, 

the DCS console will be the only interface necessary. The operator will use the DCS console to interface 

with the system as if actually running the plant from the control room. The operator can page through the 

graphics and view the conditions of the process, change set points on the controllers to monitor the 

results, and start/stop motors. 

3.23 PRINTING THE MODEL 

IDEAS decides the type of item to be printed based on the type of window that is active when the Print 

command is chosen. For instance, if a plotter is active, the command in the File menu reads "Print Plotter." 

To print, choose the Print command from the File menu. If a Notebook or a library window is active, the 

standard Print dialog box appears. If another window (such as the model worksheet) is active, two dialog 

boxes open in sequence: an IDEAS Print dialog box and then the standard Print dialog box. 

IDEAS Print dialog box is where the user selects what should be printed. As seen below, the type of dialog 

box shown for printing depends on the type of window active when the Print command is selected. 

After the user selects what to print, the standard Print dialog box is used to specify particulars about the 

print job. For example, the user can set the number of copies to be printed and (for worksheets and 

Notebooks) the range of pages. The configuration of the standard Print dialog box differs depending on 

the operating system and the type of printer used. The types of items that IDEAS can print are: 

3.23.1 MODEL WORKSHEET 

A picture of the worksheet as it appears on the screen. 
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3.23.2 DIALOG BOX 

A picture of the dialog box. If the dialog box has a data table, select whether or not to print all of the data in 

the table. 

3.23.3 PLOTTER 

The plot and, optionally, the data table. 

3.23.4 NOTEBOOK 

The contents of the notebook as it appears on the screen. 

3.23.5 HELP TEXT 

The text from the current help choice. 

3.23.6 TEXT FILE 

The text in the file. 

3.23.7 LIBRARY WINDOW 

A picture of the library window. 

3.23.8 STRUCTURE WINDOW 

All the panes from the structure window of an object. When the Print command is selected with the 

worksheet, dialog box, or plotter active, the following IDEAS dialog box opens before the standard Print 

dialog box: 

 

Figure 32: IDEAS Print Dialog Box 
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Depending on what type of item is printed, some of the options might be dimmed since those selections 

are not available for some items. The options are: 

3.23.9 MODEL WORKSHEET 

Prints the contents of the worksheet. 

3.23.10 ADD FRAME 

Puts a border around the printed worksheet. 

3.23.11 TOP LEVEL ONLY 

Only shows the worksheet’s top level (not the contents of hierarchical objects). 

3.23.12 LEVELS 

Specifies how many levels of hierarchical objects to print. 

3.23.13 NOTEBOOK 

Prints the contents of the Notebook. 

3.23.14 ALL BLOCKS 

Specifies that the options below apply to the dialog boxes of all objects in the model. 

3.23.15 ONLY SELECTED BLOCKS 

Specifies that the options below apply only to the dialog boxes of selected objects. 

3.23.16 DIALOG BOXES 

Prints the contents of the dialog boxes. 

3.23.17 DIALOG BOX DATA TABLES 

Prints the data tables in dialog boxes. 

3.23.18 TOP PLOT ONLY  

Prints only the visible plot. 

3.23.19 ALL PLOT PAGES 

Prints all four of the plot pages. 
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3.23.20 PLOT DATA TABLES 

Prints the tables in the plotters. 

3.23.21 PRINT AND PAGE SETUP HINTS 

When printing the model worksheet or the notebook, the user can choose to print only some of the pages 

using the standard Print dialog box. The Show Page Breaks command from the File menu displays the 

page breaks in the model. It also shows the page numbers in the upper left-hand corner. 

The Show Block Numbers command in the Model menu causes object numbers to appear on their icons. 

Block numbers are unique identifiers for each object and appear in the title bar of the object’s dialog box. 

Choosing this command before printing the model worksheet and dialog boxes will help match dialog 

boxes of objects with their icons in the model. 

Depending on the type of printer, the standard Print dialog box may give choices for grayscale/color 

printing. Color may come out looking better than black-and-white but takes much longer to print. 

The Page Setup dialog boxes have many settings that affect printing. For example, to save paper and only 

produce a thumbnail sketch of a large model, use the setup dialog box to specify a reduction of 50% of the 

image. The user can also switch between portrait and landscape printing if the printer supports both. 

IDEAS Show Page Breaks command comes in especially handy here. If the printer supports Graphics 

Smoothing and Text Smoothing, turning these off makes IDEAS printed images easier to read. 

3.23.22 PRINTING MODEL WORKSHEETS TO PDF 

The Models can be printed to PDF using any installed PDF software. 

1. Open the worksheet and go to File menu. 

2. Click on Print setup option. 

3. Select the PDF software in the Name field and Size as 11x17 and orientation as landscape. 
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Figure 33: Print Setup Options 

4. Click on the Properties button. Go to Layout tab and click on Advanced button. It will open the 

following dialog box. Set scaling to 60% as this is the General Standard used by ANDRITZ Inc. Now, 

the worksheet contains grey colored borders with numbers present on the upper left-hand corner of 

the border. Fit the corresponding sections into those borders. 

 

Figure 34: Print Setup Advanced Options 

5. Once the print options are set click on File/Print to print it to PDF and save the file. 
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SECTION 4. SPECIAL FEATURES 

4.1 STREAM NUMBERING 

The user can name the IDEAS streams using N-Click feature. To make this work, the worksheet must 

contain Stream Number Center object from EXECUTIVES library. 

Open Stream Number Center dialog box. In the Inputs tab, select SN Tag type as From BN-BN and type 

S: in the SN Tag prefix field. Now, the user is able to name the stream with N-Click. Hold N key and left- 

click with mouse on the connection line. The user can hide all the Stream Number objects with the Hide 

SN objects option checked. See the below figure for details. The syntax of stream numbers follow with S 

:< BN1>-<BN2>. The user can see all the Stream Numbers in the table provided under Displays tab. 

 

Figure 35: IDEAS Stream Number Center Dialog Box 

 



 

IDEAS™ v6.5.0 Page 55 of 58 
 

4.2 S-CLICK 

The user can see the simplified details of an object or stream by S-clicking on the object or stream. This 

feature will only work when the simulation has been run at least once. Hold down the S key on the 

keyboard and click on an object with the mouse. A table will appear that shows information such as flow 

into and out of an object and various other data. Please note that this feature will not work for Hierarchical 

objects. See the below figure which is an S-click display of heat exchanger. 

 

Figure 36: IDEAS S-Click Display 

4.3 D-CLICK 

Another way to monitor objects is by using the D-Click feature. For this feature to work, the Display 

Manager object from EXECUTIVES library should be present on the worksheet. Hold down the D key on 

the keyboard and click on an object with the mouse (the simulation does not have to be running). A display 

will appear that shows information such as flow into and out of an object and various other data (see 

below figure, which is a D-click on the Heat Exchanger object).  

The user can also change the display parameters and units for both the S-click and D-click displays using 

Display Manager Object. Go through the help file of the EXECUTIVES library to know more about Display 

Manager Object. 
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Figure 37: IDEAS D-Click Display 

4.4 SCENARIO IMPORTING 

The user can send parameters to IDEAS model from outside IDEAS using Scenario Importer object which 

is under DYNAMIC DATA EXCHANGE library. For more information, please refer the IDEAS help text of 

the DYNAMIC DATA EXCHANGE library. 

4.5 STREAM EXPORTING 

The user can send parameters and stream information of IDEAS model to outside IDEAS using Stream 

Exporter object which is under DYNAMIC DATA EXCHANGE library. For more information please refer 

the IDEAS help text of the DYNAMIC DATA EXCHANGE library. 

4.6 DYNAMIC DATA EXCHANGE 

IDEAS is capable of sharing data with another application by creating a DDE link. For more information 

please refer the IDEAS help text for the DYNAMIC DATA EXCHANGE library. 
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SECTION 5. CONTACT US 

5.1 IDEAS PRODUCT TECHNICAL SUPPORT 

The user can reach product technical support by calling one of the numbers listed below. Technical 

Support is available for all registered users. 

 Support Email: simulation.support@andritz.com 

 Sales E-mail: automation-sales@andritz.com  

 Internet www.andritz.com/automation.htm  

 Phone: (USA) +1 404 370 1350; EST 8:00 A.M. to 5:00 P.M. 

General comments regarding IDEAS Simulation Support: 

 Software support inquiries should be directed to our support team: email simulation.support@andritz.com 

or call us at the phone number shown above. Using the email address ensures that someone will 

receive your inquiry even when others are not in the office.  

 Please send us the model in question, or a representative smaller model, the IDEAS Version Number, 

error message log, any custom libraries, and any applicable snapshot of the issue if applicable so that 

we may resolve the issue as quickly as possible. 

 We also may require the IDEAS Serial Number. 

5.2 REMOTE DIAGNOSTIC 

Remote diagnostic support may be a possibility as well. 

5.3 FURTHER CONTACT INFORMATION 

Office locations of the Automation Solutions Division of ANDRITZ. Please contact us for information on 

IDEAS Software Sales, Training, and Support. 

125 Clairemont Avenue, Suite 570 

Decatur, GA 30030, USA  

Phone: +1 (404) 370 1350 

1801 Roeder Avenue, Suite 112 

Bellingham, WA 98225, USA  

Phone: +1 (360) 714 0787 

13700 International Place, Suite 100 

Richmond, BC V6V 2X8, Canada 

Phone +1 (604) 214 9248 

Isidora Goyenechea 3600 

of. 202, Las Condes 

Santiago, Chile 

Phone. +56 (2) 462 4600 

mailto:Simulation.Support@Andritz.com
mailto:automation-sales@andritz.com
http://www.andritz.com/automation.htm
mailto:Simulation.Support@Andritz.com
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Level 4, Manyata Tech Park 

Magnolia, Manyata Embassy Business Park 

Nagawara 

Bangalore, India 

Phone: +91 (80) 2544 4640 

 

5.4 IDEAS AUTHORIZED TRAINING SESSIONS 

IDEAS provides Hands-On training courses to assist the user in learning how to utilize our powerful 

dynamic simulation tool. We provide standard 3-, 4-, and 5-day training sessions, and also customer 

training sessions. 
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Appendix A. Pressure/Flow Network 

The IDEAS pressure/flow network solution method is in many ways unique. The hybrid solution techniques 

(combining sequential modular, emulated simultaneous, and simultaneous techniques) used allow the user to 

quickly isolate any problem areas on the model worksheet. Many built-in user messages lead the user through 

any possible interconnection problems. The connection of the various objects together with a mouse is all that is 

necessary to create the global solution array that the global solver converges. It is automatic and transparent to 

the user. (See overview description of solvers in the User Manual’s introductory overview section.) 

The global pressure/flow solution is quite robust and is stable with most piping configurations. It is possible, 

however, to create configurations that will have trouble converging. In the incompressible network, the solver 

generally has trouble converging a node that is connected to a pipe that has a very high flow to pressure 

relationship (i.e., a very small delta pressure causes a very large flow). This translates into very large diameter or 

very short pipes. When experiencing stability problems in a node (i.e., the pressure is oscillating and the flows 

into and out of the node are not balanced), look at the pipes that are connected. If one or more are very short or 

are very large in diameter then that is the most likely problem. Depending upon the situation, it may be able to 

combine several pipes into one longer one or to remove the short pipe if it is negligible to the solution. 

Alternatively, the user may be able to increase the pressure drop in the pipes (effectively making them longer) by 

artificially increasing the fitting resistances or pipe roughness value if the exact pressure drop calculation in the 

short pipe is not critical. Finally, if the exact piping configuration is necessary, and it is unstable, then the delta 

time can be reduced to increase stability. This reduction will consume more CPU time, but should help the 

unusual pipe configuration to converge. Looking at the Solver- Fluid Flow dialog box will reveal the object 

number of the worst node on the model worksheet and the magnitude of the convergence error at that node. The 

Find Block function under the Model menu will go to the offending node. 

The solver has global access to all of the stream arrays on the worksheet as well as the critical object 

parameters like pipe dimensions, fluid viscosities, etc. At the end of each simulation step, the solver provides an 

emulated simultaneous convergence. The solver sequentially accesses all pressure/flow objects on the 

worksheet; then after grouping them to minimize execution time, the solver proceeds through each pressure/flow 

object converging the nodes and calculating the flows for the flow objects until the user-specified convergence is 

reached. The equations used are given in the specific documentation for the pipes/valves, the nodes and the 

solver objects. 

A.1 Incompressible and Compressible Fluids Capability 

There are two different pressure/flow networks: one for incompressible fluids and one for compressible fluids. 

They both use the same objects and are selected in the dialog boxes of the pipes, valves, and pressure nodes. 

The compressible solution technique is more demanding than the incompressible technique. The IDEAS 

compressible solution is completely implicit and uses a matrix technique to solve for node pressures. The 

compressible solution technique takes into account the momentum balance, which allows for modeling the 

"mass" or "pipe packing" phenomenon in gas pipelines. The incompressible network is a lower fidelity solution 

technique but is faster in terms of execution speed and is adequate in fidelity for almost all incompressible flow 

applications. 
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When using the compressible option, a smaller delta time step is often required to achieve numerical stability 

and convergence, thereby, consuming more CPU time. The delta time can therefore be set independently for the 

compressible and the incompressible portions of a model in the Discrete/Continuous Executive object (see the 

description of scan classes in Appendix B). 

A.2 Pressure/Flow and Boundary Objects 

Objects whose flows and pressures are calculated by the global solver are often referred to as Pressure/Flow 

objects. These include pipes, valves, pumps, compressors and pressure nodes as well as some other more 

complex equipment that, due to the fast response nature of its flows or pressures, are included in the global 

solution. Objects that calculate their own flows or pressures independent of the global solver are objects that by 

their very nature respond slowly enough that they appear to be external sources or sinks to the pressure/flow 

network and are referred to as Boundary objects. Boundary objects solve their internal equations via sequential 

or simultaneous solution methods as selected by the object developer (see optional Developers Kit manual). 

Certain rules describe the way objects must be connected on the worksheet for the pressure/flow solver to 

function properly. First, the user will see two different types of connectors on objects; a single box (an input 

connector looks like this and an output connector looks like this ); these connections are scalar signals or 

just a single number. These connections are used for control signals and other data paths that require only a 

single number. The other type of connection is a double box (the input connector looks like this  and the 

output connector looks like this . These represent stream array connections. Stream connections pass an 

array of information through them with information such as temperature, pressure, flow, enthalpy, density and 

mass fractions of various components in the stream. Stream connections are used wherever a process stream 

passes. Some objects can have both types, for example a flow transmitter has a stream connection, which 

connects to another stream connection and a scalar connector which provides a flow value to a controller, plotter 

or other object. 

All objects that have stream connections are color-coded and by connecting green to green and red to red the 

rules are automatically followed. 

Note: Even though some green to red stream array connections can be made on the worksheet, the simulation 

will not run. 

A simple explanation of the purpose of these color coded connections follows: 

When two objects are connected together with stream connections, the connection represents only one specific 

place in the piping system as shown below. 

 

Figure 38: Color Coded Connections 

(Connect GREEN to GREEN and RED to RED) 
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Only one array is created in computer memory to which both connectors, and therefore both objects, have 

access. Since there is only one place to put the flow value and only one place to put the pressure value for this 

point, both objects cannot define both values or they would overwrite each other. There are, therefore, two 

different types of stream connections: 

FLOW CONNECTION: The object with a FLOW connection can define the flow at this connection but not the 

pressure. A flow input connection is GREEN. A flow output connection is RED. 

PRESSURE CONNECTION: The object with a PRESSURE connection can define the pressure at this 

connection but not the flow. A pressure input connection is RED. A pressure output connection is GREEN. 

It makes sense to connect these connectors in an alternating fashion so that one defines the flow and other 

defines the pressure and they do not overwrite each other. Indeed, if a pressure connection is connected to a 

flow connection and vice versa, the simulation will alarm and point out the problem area. 

The pressure/flow objects have either all pressure connections or all flow connections but some of the boundary 

objects can have mixtures of them. Since the pipes and valves can calculate their flows as a function of the 

pressures at either end, they have flow connections. Conversely, the pressure nodes calculate their pressure as 

a function of the flows going into them. 

Another way of stating this is that all flow objects (those with flow connections) must either be connected to a 

node or a boundary object that is a pressure source such as a tank inlet or outlet or a source set to pressure 

source mode. 

Table 1: Pressure Flow Objects 

Object Type 

Pipe Flow 

Valve Flow 

Pump Flow 

Compressor Flow 

Aftercooler Flow 

Node Pressure 
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Table 2: Boundary Objects 

Object Type 

Tank 
Pressure  
(Except a tank overflow, which is a flow connector) 

Sink 
Can be a flow object or pressure object,  
which can be selected from Dialog box 

Source 
Can be a flow object or pressure object,  
which can be selected from Dialog box 
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Appendix B. Scan Classes 

IDEAS allows the user to specify different scanning rates for different classes of objects. The 

Discrete/Continuous Executive object has a dialog box that looks like this: 

 

Figure 39: Discrete/Continuous Executive Dialog Box 

There are two types of scan classes: Selectable and Dedicated. 

B.1 Selectable Scan Class 

Boundary objects, i.e., those that are not included in the global solver solution (see Appendix A for further 

explanation) can be assigned to one of five separate scan classes. Although they are all defaulted to be equal to 

one (1) second, each of the selectable scan classes can be set to a different number. Scan class zero is always 

equal to the overall worksheet delta time set up under the RUN menu, however. Each boundary object should 

default to scan class zero so that it runs under the overall delta time provided by the IDEAS executive as set up 

under the RUN menu. This scan class can be changed to scan class 1 through 4, allowing the object to run at a 

different rate from the other objects on the worksheet. 

B.2 Dedicated Scan Class 

The dedicated scan classes are scan classes reserved for special type objects. The incompressible 

pressure/flow network, the compressible network and the PLC objects are the types of objects now using 

dedicated scan classes. This type allows the user to specify a scan time for the compressible network objects, 

for example, and each pressure/flow object that is set to compressible will automatically use this scan time. 

Example: A tank object is changed to scan class 1 and the scan class 1 entry in the Discrete/Continuous 

Executive dialog box is set to 4.0. The tank will execute only every 4 seconds. 
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Objects that perform time-related functions like integration can be adversely affected by scan classes other than 

the pressure/flow scan class (that is the scan class that updates the flows). In this example, the tank will 

integrate the flows into it only every four seconds so that some information will be lost. In the following example, 

when the tank runs only every 4.0 seconds, it has no choice but to use the flow that it sees at second 1.0, 

second 5.0, etc., to integrate the mass in the tank.  

If the flow is not changing there is no error, but if the flow changes the error can be significant: 

Tank Integration Example: 

Scan Class 0 = 1.0 second 

Scan Class 1 = 4.0 second 

Incompressible  

Scan Class = 1.0 second (flow update time) 

Table 3: Scan Class Example  

Time 
(s) 

Flow into Tank 
(kg/s) 

Tank Contents  
(Scan Class 0) 

Tank Contents  
(Scan Class 1) 

1 10 10.0 (10 x 1 s) 40.0 (10 x 4 s) 

2 15 25 40 

3 20 45 40 

4 25 70 40 

5 30 100 160 

6 35 135 160 

7 40 180 160 
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Appendix C. Creating Hierarchical Objects, New Libraries, Blocks and 

Objects 

The user may remember that a hierarchical object is a special object that contains other objects (even other 

hierarchical objects) connected together like a model. 

A hierarchical object is unique: it has some characteristics of an object and some characteristics of a model 

worksheet. Depending on how they are saved, changes to hierarchical objects may be reflected in all instances 

of that object (pure hierarchy) or they may be only reflected in that one particular instance of the object in the 

model (physical hierarchy). Whether a hierarchical object is considered pure or physical depends on whether the 

user saves it to a library and whether subsequent changes are saved to the master object in the library. This is 

discussed in more detail below. 

Hierarchical objects have two windows: the layout pane window (which is what the user sees if a hierarchical 

object is double-clicked) and the structure window. The structure window contains another view of the layout 

pane and is where the user builds a new hierarchical object or makes changes to an existing hierarchical 

object’s icon, connector position, and so forth. Hierarchical structure windows are discussed in "Building a new 

hierarchical object." 

When the user opens a hierarchical object by double-clicking on it, instead of seeing a dialog, a layout of the 

submodel in the hierarchical window is seen. For example, an open hierarchical object would look like this: 

 

Figure 40: Hierarchical Object Layout Pane 

C.1 Two Methods for Creating Hierarchical Objects 

As discussed below, there are two methods for creating hierarchical objects: 

 Select some objects from a model and choose Make Selection Hierarchical from the Model menu 

 Create a new hierarchical object with the New Hierarchical Block command from the Model menu 
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If the user wants to use hierarchical objects to reduce the complexity of an existing model, probably the first 

method will be used more often. On the other hand, if the user is building a model from the ground up, the user 

may want to create new hierarchical objects from scratch as well. Both methods are described in detail below. 

No matter which method the user uses to create them, all hierarchical objects have the following in common: 

The user can copy them to other areas of the model or to other models and use them like any other object. The 

user can change the settings of an object within a hierarchical object by double-clicking on the hierarchical 

object, then double-clicking on the desired object’s icon. 

The user can treat hierarchical layout windows like model windows: the user can add objects from a library, 

create hierarchical objects, draw items, type labels and other text, clone dialog items onto them, and so on. 

The user can modify a hierarchical object’s icon, connectors, or help text by holding down the Alt key and 

double-clicking on the object’s icon. This opens the hierarchical object’s structure window. 

Unlike other objects, hierarchical objects are saved directly in the model as copies. This characteristic allows 

them to be treated much like a copy of a portion of the model. The user can copy a hierarchical object to another 

part of the user’s model and make changes to its hierarchical window without affecting the original hierarchical 

object. This is also known as physical hierarchy. 

The user can also choose to save a hierarchical object in a library, in which case it can be treated much like a 

regular object. When the user makes changes and also chooses to update all instances of that object, the user 

has pure hierarchy. 

C.2 Making a Selection a Hierarchical Object 

To make several objects into a single hierarchical object: 

Select the objects and any desired draw items by dragging over them or by holding down the Shift key and 

clicking on each of them. 

It should be noted that the selection tool the user uses determines what is selected. See note below for 

information about including named connections in the selection. 

Choose Make Selection Hierarchical from the Model menu. The user will see the following dialog: 

 

Figure 41: Make Selection Hierarchical Dialog 
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Enter a descriptive name for the object and click the Make H-object button. 

Note: This action cannot be undone. If the user accidentally includes more objects than the user intended in 

the hierarchical object, the user must remove them from the object’s submodel and put them back in the 

model using the Cut and Paste commands from the Edit menu. 

When the user uses the Make Selection Hierarchical command, IDEAS makes all the connections for the user 

and replaces those objects in the model with the new hierarchical object, including a default icon. To verify that 

this is so, double-click on the hierarchical object’s icon and look at the submodel. The window that holds the 

submodel is given below: 

 

Figure 42: Hierarchical Object Layout Pane 

Note: Named connections only work on one level in a hierarchical model: the data will not be transferred 

between levels. This means that a named connection on one level will not communicate with a 

corresponding named connection in an object at a lower or higher level. If the user includes named 

connections inside a hierarchical object, the user will have to provide a connector if the data is supposed 

to go outside the hierarchical object. 

The user can alter aspects of the object such as moving the connectors or adding art to the icon. See the section 

on "Modifying hierarchical objects" for more details. 

Note: When the user makes a selection hierarchical, the hierarchical object is saved only in the model. If the 

user wants to save it in a library, the user must use the Save Block As command, described later in 

this section. 

Building a New Hierarchical Object 

To build a new hierarchical object, the user must have a model window open. When the user selects the New 

Hierarchical Block command in the Model menu, IDEAS prompts the user for a name; it then opens up a 

structure window for the user. 
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The structure window for a new hierarchical object looks like: 

 

Figure 43: Structure Window for Hierarchical Objects 

This structure window is divided into four panes, which are work areas. The upper left-hand pane is the icon 

pane for designing the object’s icon and adding connectors. The upper right-hand pane is the help pane for 

writing the help text for this object. The lower left-hand pane is the connector pane which contains the names of 

the input and output connectors for the object. The large pane on the lower right is the layout pane, where the 

submodel that makes up this hierarchical object will be built. The layout pane is what the user sees in the 

hierarchical window when the user double-clicks a hierarchical object’s icon. 

As discussed in detail below, the steps in building a new hierarchical object are: 
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Build the Submodel 

Add connectors to the icon (and, optionally, modify the icon). 

Save the hierarchical object. The user can also save it to a library, if desired. Connect the new hierarchical 

object to the other objects in the model. 

C.3 Building the Sub Model 

To build a sub model in a hierarchical object, use the same methods used when the user built a model in 

Section Error! Reference source not found., Error! Reference source not found.. Use the Library menu to ad

d objects to the layout pane, or drag them from library windows. Connect objects in the normal fashion. 

If the user prefers, the Copy and Paste commands from the Edit menu can be used to copy a portion of an 

existing model into the layout pane to be used as a submodel. Once the sub model is built, the user can modify 

the layout or enhance it with drawing objects or text as discussed in "Modifying hierarchical objects" below. 

C.4 Modifying the Icon and Adding Connectors 

The hierarchical object starts with a default icon—a white square. The user can modify this icon, for example, by 

changing its shape or color, or the user can delete it and create a new one. To do this, draw an icon with the 

drawing tools in the toolbar, or paste a picture in from another program. 

Since the hierarchical object needs to the main model, the user must add the appropriate connectors. Some 

hierarchical objects have both input and output connectors, while others have just one kind. Also, hierarchical 

objects can have either value or item connectors, or both. 

When the hierarchical structure window is the working window, the toolbar has additional tools from what the 

user saw in Error! Reference source not found., Error! Reference source not found.: 

 

Figure 44: Structure Window Toolbar 

The first new tool on the palette, , is used to add animation objects. The next four icons add connectors: scalar 

(  ), stream array(  ), universal (  ), and diamond(  ). 

There are four steps to adding a connector to a hierarchical object: decide the type of connector to add; add the 

connector; determine if the connector should be an input or an output connector; and connect the objects in the 

layout pane to the connector. 

First, decide which type of connector to use. The user will typically use value or item; the connector type must 

match the main input and output connectors for the submodel in the layout pane.  
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To add a connector, click on the connector in the toolbar, then click in the icon pane at the desired position near 

the edge of the hierarchical object’s icon: 

 

Figure 45: Output Connector Added to Cyclones Icon 

This creates the connector in the icon pane, lists it in the connector pane, and adds a connector text object (very 

much like a named connection) in the layout pane. The icon pane has a grid; if the user wants to align a 

connector without using the grid, hold down the Alt (Option) key as the user moves the connector. 

Note: If the user chooses the wrong type of connector, just click on that connector on the icon pane to select it. 

Now click on the correct connector type in the toolbar. The connector will change to the new type. 

Every connector has a unique name. The ending of the name of the connector ("In" or "Out") defines whether it 

is an input or output connector. When the user adds connectors to the icon, they are all initially input connectors. 

To make one of these connectors an output connector, change its name to something that ends with "Out." The 

user can change the connector name the way he wants it, but the name must end in "In" or "Out." To change the 

name of a connector, select the connector name in the connector pane. Type a new name or edit the name, and 

press the Enter key or click anywhere else in the connector pane to save the edited name. 

Once the user has added the connector to the icon, the user needs to connect the connector text object in the 

layout pane to the appropriate objects. The user does this the same way as connecting a named connection to 

an object in the model window: drag a line from the connector of an object in the layout pane to the connector 

text. When the line thickens, the connection is made. Named connections are described fully in Section Error! R

eference source not found., Error! Reference source not found.. 
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Figure 46: Hierarchical Connector Connected to Submodel 

C.5 Saving the Object 

The user can save the new hierarchical object so that it is saved just in the model or in a library. If the user 

closes the structure window by clicking on its close box (or by choosing Close in the File menu), the hierarchical 

object will be saved in the model but not in the library. See "Saving hierarchical objects" below for more details. 

C.6 Connecting the Hierarchical Object in the Model 

To connect the finished object to the model, first close the structure window if it is open. Then, simply connect 

the connectors on the hierarchical object to other connectors in the model, just as the user would with any other 

object. 

C.7 Saving Hierarchical Objects 

Once the user has built a hierarchical object, the user can save it only to the model or also to a library: 

The user can make hierarchical objects that are saved with the model but which do not exist in libraries. When 

the user makes a selection hierarchical, the hierarchical object is automatically saved with the model when the 

model is saved. If the user makes a new hierarchical object, or makes changes to the layout pane window of an 

existing hierarchical object, then click its close box to save it, it exists only in the model. The user can copy such 

a hierarchical object to other parts of the model, or even to other models using the Clipboard. Each instance of 

the object in the model can then be made unique by modifying it as described below. When the user changes 

one hierarchical object, the other objects do not change at the same time. 

The user can save a hierarchical object in a library, but what is saved in the library is only a "snapshot" of the 

hierarchical object at the time the user saved it. If the user later modifies that hierarchical object on the model 

worksheet, the changes may or may not be reflected in the master object in the library. For example, if the user 

modifies the submodel of a hierarchical object from a library, the changes will not be saved in the master library 

object unless the user tell IDEAS to save those changes, as described below. 
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To save a hierarchical object in a library or to cause changes made to a hierarchical object to also be made to its 

master object in a library: 

If it is not already open, open the structure window of a hierarchical object by holding down the Alt (Option) key 

as the user double-clicks the object’s icon in a model window, or select the object and choose Open Structure in 

the Define menu. (The structure window is the active window when the user is building a new hierarchical object 

or when the user is modifying a hierarchical object’s icon or connectors). 

Choose Save Block As from the File menu. In that dialog, choose a library for the hierarchical object and install 

the hierarchical object in the library. Then close the hierarchical object and choose one of the save options, as 

discussed in "Modifying hierarchical objects." 

It is strongly recommended that the user does not save hierarchical objects in the libraries that come with 

IDEAS; instead make a new library for the user’s hierarchical objects. 

A hierarchical object that is saved in a library has its name listed in the library in italics. Like other objects, 

hierarchical objects that are saved in libraries list the names of the libraries in their structure window. If no library 

is listed, the hierarchical object is not saved in a library. The user can also tell if a hierarchical object is saved in 

a library by selecting the object in the model window and choosing Get Info from the File menu. 

If the user modifies a hierarchical object that is saved in a library, the changes may not be saved to the master 

object in the library. Saving changes to a hierarchical object that is in a library is discussed in the section on 

"Results of modifying hierarchical objects" below. 

C.8 Ways to Modify Hierarchical Objects 

How the user modifies a hierarchical object depends on what it is that the user wants to modify. Typically, the 

user might want to modify the settings of the objects in the submodel, the layout and appearance of the 

submodel, or the hierarchical object’s icon, connectors, or help: 

The user can change settings for a submodel’s object by double-clicking on the object’s icon in the layout pane 

window. The user can also clone dialog items onto the layout pane as discussed in Error! Reference source n

ot found.. The user usually accesses the layout pane window by double-clicking on the hierarchical object’s 

icon, although the user can also access it in the hierarchical structure window. 

The user can modify the submodel as the user would any model: add additional objects, create hierarchical 

objects, type text and add drawing objects, or move objects and connectors within the hierarchical layout pane 

window. The user does this by double-clicking on the hierarchical object’s icon to access its layout window. 

Then, use the Library menu and tool bar to add objects, text, and so on. This is the recommended method to use 

if the user wants to modify the submodel only in this one instance of the hierarchical object. 

The user can modify the hierarchical object’s icon, connectors, or help in the object’s structure window. If it is not 

already open, open the structure of a hierarchical object by holding down the Alt key as the user double-clicks 

the object’s icon in a model window, or select the object and choose Open Structure in the Define menu.  
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The user can also use this method to modify the submodel in the layout pane, although this is more common 

when the user wants to save the object in a library. The procedures for making changes are the same as for 

building a new hierarchical object, described above. 

Note: If the hierarchical object is in a library, the user cannot modify its structure by double-clicking on its icon 

in the library window. The user must work directly on the worksheet, and the user must use a 

hierarchical object originally copied from the library menu or library window. 

C.9 Modifying Hierarchical Objects  

The user can add many enhancements that will improve the hierarchical objects: 

 Add text, drawing objects, and pictures (layout window or structure window must be open) 

 Clone dialog items (layout window or structure window must be open) 

 Change the icon (structure window must be open) 

 Rename the object (structure window must be open) 

 Add help (structure window must be open) 

To access the layout pane directly, double-click the hierarchical object in the model. To access the hierarchical 

structure window, hold down the Alt (Option) key while double-clicking the hierarchical object in a model window, 

or select the object and choose Open Structure in the Define menu. The user can also access the layout pane 

by opening the structure window, although this is less common. 

C.10 Adding Text, Drawing Objects, or Pictures to the Layout Pane 

The user can add text, drawing objects, and pictures to the hierarchical object just as the user does in a model. 

To do this, open the layout window by double clicking on the hierarchical object’s icon; then use the tools in the 

toolbar to enhance the submodel. 

C.11 Cloning Dialog Items to the Layout Pane 

The user can clone dialog items from the dialogs in submodel objects directly to the layout pane. This lets the 

user see the items when the user double-clicks the hierarchical object’s icon. The method for doing this is 

identical to the normal cloning method the user learned in Error! Reference source not found.. 

C.12 Changing the Icon 

The user will probably want to change the icon for the hierarchical object, since IDEAS starts with just a plain 

rectangle. The user may want to change the icon to better suit the purpose of the hierarchical object. 
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To Change the Icon 

Open the structure window by holding down the Alt (Option) key while the user double-clicks on the object’s icon, 

or select the hierarchical object and choose Open Structure in the Define menu. 

Click on the icon in the icon pane, and change or delete it (but be careful not to delete the connectors) 

Use any of the drawing tools to make the icon. The user can also paste pictures from outside of IDEAS into the 

icon pane. 

Note: It is very important that the user does not delete any connectors. If the user does so, IDEAS will warn 

the user. If the user accidentally deletes a connector, the user can undo it or the user can add another 

one, but the user must then check the object’s connections in the model. 

The user can change the pattern and color of the default icon without deleting it; just select it and choose new 

colors and patterns. If the user wants a different icon shape, the user must delete the default icon and draw a 

new one. See Error! Reference source not found. for information on how to use the drawing tools. Drawing in t

he icon window is just the same as drawing in the model window. 

C.13 Renaming the Object 

When the structure window of a hierarchical object is open, the user can rename the object by choosing Rename 

Block from the Define menu. 

C.14 Adding Help 

The user can change the help text by editing in the help pane in the structure window. The user can type in text, 

or use Copy and Paste to move it from other objects. The user can change the style of text in the help pane by 

selecting it and giving commands from the Text menu. 

C.15 Results of Modifying Hierarchical Objects 

There are different results when the user modifies hierarchical objects, depending on whether the user modifies 

its layout pane window or structure window, and whether the object is saved in a library: 

If the user modifies a hierarchical object’s submodel in the layout pane window, those changes only apply to that 

object. Changing a hierarchical object’s submodel is similar to changing parameters in a regular object’s dialog: 

the changes affect only that instance of the object on the worksheet and are saved with the model. This is true 

even for hierarchical objects that were originally saved in libraries. 

If the user modifies the structure of a hierarchical object that is not saved in a library, those changes only apply 

to that object. This has the same result as when the user modifies a hierarchical object’s layout pane window.  
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For example, the user can make several copies of that hierarchical object in a model, but when the user changes 

one of the copies, the other objects remain unchanged. 

If the user modifies the structure of a hierarchical object that is in a library, the user can choose how the user 

wants those changes reflected: 

 Only in this instance of the object on the worksheet 

 Also in the master object in the library (only affects objects placed in the model from the library after the 

change has been made)  

 Also in all instances of the object in open models (note that this does not affect models that are not open at 

the time); this is also called pure hierarchy 

For example, when the user closes the structure window of a hierarchical object from a library, IDEAS prompts 

the user with the following dialog: 

 

Figure 47: Save Changes Dialog Box 

C.16 Closing the Structure Window 

Choose "Save To This Block Only" to save the changes just in this object or "Also Save to Library" to make the 

changes appear in the library holding the master object. "Also Update Other Blocks..." makes the changes to all 

copies of that object that came from the library and are used in any open models but not to models that are not 

open. 

C.17 Creating new Libraries and New Blocks or Objects 

The user can create new libraries and new blocks in IDEAS using the ModL Programming language. For 

detailed information on Creating Blocks, please refer to the ExtendSim User Manual and the ExtendSim 

Developer Reference. 
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Appendix D. Sensitivity Analysis 

As discussed in 3.20: Running the Model, sensitivity analysis allows the user to conduct controlled experiments 

to explore how much of an impact a particular parameter has on model results. IDEAS’s sensitivity analysis 

features make it easy and convenient to specify the parameter the user wants to investigate and settings to use 

for the analysis. 

D.1 Introduction to Sensitivity Analysis 

Sensitivity analysis works with all numeric parameter entry items (the rectangular fields in the objects’ dialogs in 

which the user keys in numbers). It will also work with clones of those numeric items. The user enters the 

sensitivity settings for a particular dialog parameter using a special key (Refer D.2 below) as the user clicks on 

the parameter or its clone. The user can add sensitivity to as many dialog values as the user needs. However, it 

is recommended that the user only vary one or two dialog values at a time so as not to confuse the analysis. 

Once the user has "sensitized" a parameter, the user specifies how many simulation runs the user wants. When 

the user runs the simulation multiple times with the Use Sensitivity Analysis command checked, the user sees 

the results of varying the parameter value over the settings the user has chosen. 

The Open Sensitized Blocks command from the Model menu shows the user all the dialogs for objects that have 

sensitivity settings. This is convenient if the user has entered sensitivity settings for many parameters in a large 

model. 

D.2 Steps for Using Sensitivity Analysis 

Open the dialog of the object that has the value the user wants to vary. 

Hold down the Control key (CTRL-Windows) while clicking once on the desired numeric entry, or click on the 

desired numeric entry and choose the Sensitize Parameter command in the Edit menu. The user will see the 

following dialog: 



 

IDEAS™ v6.5.0 D-2 

 

Figure 48: Sensitivity Setup Dialog 

Be sure the "Enable Sensitivity" box is checked. As discussed below, this checkbox allows the user to 

temporarily turn sensitivity analysis off for this parameter without losing the settings. 

Specify the number of simulation runs needed for the analysis. The user can do this either in the Sensitivity 

Setup dialog or in the Simulation Setup dialog. Each setting controls the other, so that the last value selected in 

either of them controls the number of runs. 

Choose the method of sensitizing the parameter (a file, a specified range, or a random distribution, as described 

below) and enter any needed values. The choices are described in "Specifying the Sensitivity Method and 

number of Runs." 

Be sure the Use Sensitivity Analysis command from the Run menu is checked. If not, choose the command so 

that a check mark appears next to it. 

Run the simulation. 

When using sensitivity analysis, the user can investigate the effect of changing one parameter. The user usually 

plots the resulting values for that area of interest on one of IDEAS’s plotters. Although the user can use any of 

the standard plotters (such as the Plotter I/O or the Plotter Discrete Event), it is more common that the user 

would use a MultiSim plotter (to show up to four runs at a time in one plot window) or an Error Bars plotter (to 

show the mean and standard deviation of the parameters over the count of runs). 
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D.3 Specifying the Sensitivity Method and Number of Runs 

In the Sensitivity Setup dialog, the user can specify if a sensitized parameter will change incrementally, 

randomly, or from a list in a file. The three choices are: 

1. Option: Read from file 

Description: Assigns the values from a text file. This is the option the user will most likely use when performing 

ad hoc experiments. Use this if the user has the desired values in a text file that was created in IDEAS or in 

another program. If the file has more than one column separated by tab characters, the user specifies the 

desired column. Click on the Locate File button to enter a filename to be read from. 

2.  Option: Starting at ... change by... 

Description: Specifies the starting value and the amount of change. By default, the starting value is the same as 

the parameter’s value in the dialog. The user can increase the variable with a positive number, or decrease it 

with a negative number. 

3. Option: Random 

Description: Uses a random distribution to set the parameter. This is an easy way to make a single value in the 

model change randomly over many simulations while keeping the value constant within a single run. Choose 

from one of the five types of distribution and enter the distribution parameters in the options to the right of the 

distribution. The seed is the number to use for the random number generator. As in the Simulation Setup dialog, 

BLANK or 0 for the seed is random. 

The user can specify the number of simulation runs either in a Sensitivity Setup dialog or in the Simulation Setup 

command’s dialog. 

Note: The last number of runs entered in either dialog determines how many times the simulation will run. 

D.4 Turning Sensitivity On and Off 

The user can control sensitivity globally (for the model as a whole) or locally (at the dialog parameter level): Use 

a menu command to turn sensitivity analysis on and off for the model as a whole. Enable, disable, and delete 

sensitivity settings for a particular parameter in the dialog in which the parameter appears. When the user enters 

sensitivity settings for a value, sensitivity analysis is enabled as long as the "Enable sensitivity" box is checked in 

the Sensitivity Setup dialog. If the user unchecks the box, the user temporarily disables a dialog value’s 

sensitivity so that the user does not have to reenter the number for subsequent analysis. 
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If sensitivity analysis is active for the parameter (that is, if the "Enable sensitivity" choice is checked, as 

discussed above), the frame is green or solid black. If the sensitivity analysis is inactive for the parameter or if it 

is turned off for the model as a whole, the frame is red or dotted grey. The Open Sensitized Blocks command (in 

the Edit menu) shows the dialogs of all objects (objects) with sensitized parameters, regardless of whether or not 

the "Enable sensitivity" box is checked. 

To remove sensitivity settings from a parameter (as compared to simply temporarily disabling the settings by 

turning off the parameter’s "Enable sensitivity" box), open the Sensitivity Setup dialog by holding down the 

Command key and clicking on the parameter (or select the Sensitize Parameter command from the Edit menu). 

Then click the Delete button. 

Note: Editing a sensitized parameter in an object’s dialog disables the sensitivity settings for that object. When 

this happens, IDEAS automatically unchecks the "Enable sensitivity" choice. IDEAS assumes that if the 

user is editing the value, the user wants to use that new value, not the one that was entered in the 

Sensitivity Setup dialog. If the user wants to turn off sensitivity analysis for a number for the foreseeable 

future, open that item’s Sensitivity Setup dialog and click the Delete button. This will help prevent 

accidentally changing the value in a future run of the simulation. 

D.5 Reporting the Results 

In addition to multisim and error bar plotters, IDEAS’s reporting and tracing features are useful when analyzing 

output after using sensitivity analysis. 

The Report feature shows final values and the Trace feature shows values at each step or event. 

D.6 Multi-Dimensional Scenarios 

The user can enable sensitivity on more than one item at a time. For instance, the user may want to vary the 

values of two Constant objects and see the interaction between the two items. If the user sets the sensitivity for 

the parameters with the "Starting at" option, both values will increment at the same rate. For instance, if the user 

has one parameter that starts at 5 and increments by 1, and the second parameter starts at 100 and increments 

by 50, and the user runs the simulation seven times.  
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The value pairings will be: 

Table 4: Multi-dimensional Scenarios Values Pairs 

Run No.  Variable 1 Variable 2 

0 5 100 

1 6 150 

2 7 200 

3 8 250 

4 9 300 

5 10 350 

6 11 400 

Often, however, the user wants to look at all the possible combination of the two (or more) variables. In this 

example, the user would want to run the model 36 times, with the following combination: 

Table 5: Multi-dimensional Scenarios Values Pairs 

Run No. Variable 1 Variable 2 

0 5 100 

1 5 150 

2 5 200 

3 5 250 

... ... ... 

7 6 100 

8 6 150 

... ... ... 

35 11 400 
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In order to perform this kind of multidimensional analysis, the user needs to get the values from a file. The most 

convenient way to do this is to create a file that has two columns separated by a tab character with all the 

desired pairings. For instance, the file for this example would start off: 5   100, 5   150, 5   200, ... 

In the Sensitivity Setup dialogs, the user chooses "Read from file" and chooses the file name. For the first 

variable, enter "1" for the column number; for the second variable, enter "2." 
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Appendix E. Creating New Components 

E.1 Using the MP Assembler object to Create New Components 

Creating a new component, as a component record file, requires the use of the MP Assembler object from the 

MATERIAL PROPERTIES library (MP Tools submenu). 

1. Place an MP Assembler object on an IDEAS worksheet from the MATERIAL PROPERTIES library. 

 

Figure 49: MP Assembler: Component Properties Tab 



 

IDEAS™ v6.5.0 E-2 

1. In the Component Properties tab, select units (Metric or American). Enter the name of the new component in 

the field Component Name, for example, NewComp_s. Use the appropriate suffix to indicate the phase of 

the new component: _s for solid, _l for liquid, _g for gas, _aq for dissolved solid, _or for organic, _mo for 

molten metal. 

2. Enter the chemical formula, if known, in the field "Component Formula," e.g., FeCl2. 

3. Press "Create New Record" button. 

4. The tables Property, Value, and Units of the Component Properties tab are used to enter various property 

values. Enter values into the Value table in the units of the Units table. 

 Regarding Constant Values and Correlations: During simulation, IDEAS objects calculate various 

properties of their materials. If a correlation has been entered for a property, that correlation will be used 

– see also “Adding Correlations”. If no correlation is available, the value entered in the Value table will 

be used. 

Regarding Required Data: During simulation, IDEAS will use component data as required by specific 

calculations. If the required data is not provided, IDEAS will use the value 0, which will, in many cases, cause 

errant, or no value, results. Not all data shown in the Property table are necessarily required for simulation. For 

example, viscosity data is not needed for a steady-state model because only dynamic models use viscosity data 

to calculate flow through pipes and ducts. If limited component data is available, the user may want to first load 

generic (water) data into the Values table. If desired, simply press the Generic Component button to load this 

generic liquid data into the Value table. 

Then continue by entering known data, replacing any generic data in the Value table. Typical required data is 

listed below: 

 Property 1 "Phase Code" - Component Phase 

 Property 2 "Mol. Weight" - Molecular Weight 

 Property 3 "Spec. Heat (Cv)" - Specific Heat Capacity (not used for non-gases) 

 Property 4 "Spec. Heat (Cp)" - Specific Heat Capacity 

 Property 7 "Rho(T)" – Density 

 Property 9 "Rho(T,P)" – Density (not used for non-gases) Property 15 "Vis(T) – Viscosity 

 Water viscosity = 0.000993 Pa s (0.993 cP)  

 Air viscosity = 1.867e-05 Pa s (0.01867 cP) 

 Property 18 "Vis(T, P)" - Viscosity (not used for non-gases) 

 Property 27 "Enth formation" - Enthalpy of Formation at 25 degrees Celsius 

1. Press the "Save Constants" button to save the data temporarily. This does not save the component record. 

Proceed to "Saving Component Records" at the end of this document if no correlations are being added for 

this component. 
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Figure 50: MP Assembler: Component Properties – Ready to Save Record  
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E.2 Adding Correlations 

Correlations may be added to a component record for various component properties. Some property correlation 

parameters may be added directly in the Quick Fits tab of the MP Assembler object. These correlations are 

described here. Other correlations may be created from raw data using the IDEAS "MP 1 Variable Curve Fitter" 

and "MP 2 Variable Curve Fitter" objects. 

E.3 Enthalpy Correlations 

If an enthalpy correlation is not entered for a component, IDEAS will use the specific heat and enthalpy of 

formation values to calculate the enthalpy of that component at different temperatures. For components with 

constant specific heat capacity, this method is exact. However, most components have a non-constant specific 

heat capacity. For better accuracy, and if enthalpy correlations are available, enthalpy correlations may be 

entered into the component record file as described. Do not enter specific heat correlations – they are not used 

by IDEAS – enthalpy is used instead. 

The IDEAS MP Assembler object uses the following correlation for (specific) enthalpy as a function of 

temperature: 

Enthalpy = A + B*T + 0.001*C*T^2 + 100000*D/T + Hf 

Where: 

Enthalpy = Specific Enthalpy in kJ/kg, kJ/kmole, or kcal/kmole 

T = Temperature in degrees Kelvin 

Hf = Enthalpy of Formation at 25 degrees Celsius 

A, B, C, D = Enthalpy Correlation Parameters 

If a correlation is available in this form, with known values for the parameters A, B, C, and D, then the user may 

directly enter these parameters. If the user has a correlation of some other form, then the user should first 

perform curve fitting to obtain parameters according to the above correlation. Multiple enthalpy correlations for 

different temperature ranges may be used. Beyond the temperature range(s) of the enthalpy correlation(s) for a 

component, IDEAS will use the specific heat capacity to determine the enthalpy of the component. 

Entering Proper Format Enthalpy Correlation Parameters: 

If the enthalpy correlation parameters of the proper enthalpy correlation format (as described above) are known, 

they may be entered into the MP Assembler object directly. 

1. Open the dialog box of the MP Assembler object. 

2. On the "Quick Fits" tab, in the "Enthalpy" section, select the proper units (kJ/kg; kJ/kmole; or kcal/kmole) for 

enthalpy (specific enthalpy). 

3. At the top of the Quick Fits tab, there is a Correlation File Attributes table. Below this table there is a field 

labeled "Next Empty Row". Copy the value shown in the "Next Empty Row" field to the field below the 

"Create in Row" button of the Enthalpy section of the "Quick Fits" tab. 
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4. Enter correlation parameters A, B, C, D, and the enthalpy of formation at 298.15 degrees Kelvin (25 degrees 

Celsius). 

5. Enter the lower and upper limits of the applicable correlation range in the fields T_min and T_max. Multiple 

correlations may be added for enthalpy, with each correlation valid for its own temperature ranges. To add 

multiple enthalpy correlations, simply repeat this procedure for each correlation. 

6. Press "Create in Row" button to save this correlation within the MP Assembler. Values will appear in the 

"Correlation File Attributes" table, indicating that the correlation has been created (See Error! Reference s

ource not found.). 

7. Proceed to "Saving Component Records" at the end of this section if no other correlations will be used for 

this component. 

 

Figure 51: MP Assembler - Quick Fits - Enthalpy Correlation Created 
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E.4 Excess Specific Gravity (Volume of Mixing) Correlations 

If no specific gravity correlation is specified, IDEAS will assume that there is no change in volume due to mixing 

of components.  For many mixtures, this is a reasonable assumption.  If specific gravity correlations are 

available, they may be entered into the component record file for better accuracy. 

The correlation used within the IDEAS MP Assembler object Quick Fits tab for specific gravity is of the form: 

SG = A*c^2 + B*c + C 

Where:  SG = Specific Gravity 

c = Mass Fraction of Solute 

A, B, C = Specific Gravity Correlation Parameters 

1. Open the dialog box of the MP Assembler object, "Quick Fits" tab. 

2. At the top of the Quick Fits tab there is a Correlation File Attributes table.  Below this table there is a field 

labeled “Next Empty Row”.  Copy the value shown in the “Next Empty Row” field to the field beside the 

"Create in Row" button of the Specific Gravity section of the “Quick Fits” tab. 

3. Enter A, B, and C (the specific gravity correlation parameters). 

4. In the Specific Gravity section, press the "Create in Row" button to save this correlation within the MP 

Assembler.  Values will appear in the proper row of the “Correlation File Attributes” table, indicating that the 

correlation has been created (See Figure 52). 

5. Proceed to “Saving Component Records” at the end of this document if no other correlations will be used for 

this component. 
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Figure 52: MP Assembler - Quick Fits – Specific Gravity Correlation Created 

E.5 Excess Enthalpy (Heat of Mixing) Correlations 

If no excess enthalpy correlation is specified, IDEAS will assume that there is no change in enthalpy due to 

mixing of components.  For many mixtures, this is a reasonable assumption.  If excess enthalpy correlations are 

available, for better accuracy, they may be entered into the component record file as described. 
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The correlation used within the IDEAS MP Assembler object Quick Fits tab for excess (specific) enthalpy is of 

the form: 

excess_h = A*c^3 + B*c^2 + C*c + D 

Where:  excess_h = Excess Specific Enthalpy in kJ/kg 

c = mass fraction 

A, B, C, D = Excess Enthalpy Correlation Parameters 

1. Open the dialog box of the MP Assembler object, "Quick Fits" tab. 

2. At the top of the Quick Fits tab there is a Correlation File Attributes table.  Below this table there is a field 

labeled “Next Empty Row”.  Copy the value shown in the “Next Empty Row” field to the field beside the 

"Create in Row" button of the Excess Enthalpy section of the “Quick Fits” tab. 

3. Enter the excess enthalpy correlation parameters:  A, B, C, D. 

4. Enter the lower and upper limits of the applicable correlation range in the fields c_min and c_max.  See 

Figure 53.  Multiple correlations may be added for excess enthalpy, with each correlation valid for its own 

temperature ranges.  To add multiple enthalpy correlations, simply repeat this procedure for each 

correlation. 

5. In the Excess Enthalpy section, press the "Create in Row" button to save this correlation within the MP 

Assembler.  Values will appear in the proper row of the “Correlation File Attributes” table, indicating that the 

correlation has been created. 

6. Proceed to “Saving Component Records” at the end of this document. 
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Figure 53: MP Assembler - Quick Fits – Excess Enthalpy – Ready to Create 

E.6 Saving Component Records 

In the MP Assembler object, Component Properties tab, press the "SAVE NEW RECORD" button to save the 

component in text file.  Specify the name of the file, e.g. NewComponent.txt.  Save the file as a text (.txt) file. 

This component record is now available to be used within IDEAS models.  As with all components, the 

component record must be loaded into the Material Properties object within an IDEAS worksheet, 

(“Components” tab, “Load Component” button) to be available for use in that worksheet. 
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The addendum describes the advanced feature of curve fitting to create coefficients for enthalpy and other 

correlations. 

Please contact IDEAS Simulation Support team with any problems or questions. 

E.7 Curve Fitting 

Curve fitting is used to create correlations from known data.  The IDEAS object “MP 1 Variable Curve Fitter” may 

be used to create correlation parameters for many physical properties.  In this example, we will create correlation 

parameters for Enthalpy = F(T), enthalpy as a function of temperature.  The object “MP 2 Variable Curve Fitter” 

is available to create correlations based on functions of two variables.  See also the IDEAS help text for these 

two objects. 

1. Place an MP 1 Variable Curve Fitter from the Material Properties library (MP Tools sub-menu) onto the 

IDEAS model.  Open the dialog box. 

2. Choose the radio button Enthalpy = F(T). 

3. Enter data for enthalpy as a function of temperature into the Curve Fit Table on the Raw Data tab of the MP 

1 Variable Curve Fitter object.  Notice that the X column (temperature in degrees C in this case) is the right 

column, and Y (enthalpy in kJ/kg in this case) is the left column. 

4. Press the "Compute Coefficients" button.  IDEAS may announce that the order of the curve fit is one less 

than the number of data points provided, click OK. 

5. Note: On the "Curve Fit Status" tab, select the desired curve to be used (See Figure 54).  The curve fit of the 

highest order available will provide the highest level of accuracy for the correlation data provided.  However, 

for the remainder of the correlation range, a lower curve fit order correlation may be more accurate.  The 

function Enthalpy(T) should always increase with temperature, but a high-order fitted curve may not meet 

this requirement.  The button “Plot Y=f(X)” may be used to view the plot of each order correlation.  See 

Figure 56 to see the curve fit to the example data by an 8th order equation (see Figure 57) to see the curve 

fit to the example data by a 4th order equation.  Notice that the 4th order equation provides a more 

reasonable result as the enthalpy never decreases as temperature increases.  The provided data for this 

example, which is completely artificial, may be unrealistic.  Given enough quality data, the higher order curve 

will normally provide the best fitting curve for the correlation range, but sometimes, there may be limited data 

available. 

6. Select the desired curve to be used from the “Select This Curve For Database” area. 

7. Press the "Save Fit in a File" button. 

8. On the "Correlation Database" tab, press the "Save File to Database" button.  Save the file with a 

representative name, such as NewCompEnthalpy.txt. 

9. If desired, repeat this procedure to create additional enthalpy correlations for other temperature ranges of 

this component.  It may be easier, however, to simply create one correlation using all known data for 

enthalpy as a function of temperature. 

10. Open the dialog box of the MP Assembler object.  Press the "Read Correlation File" button.  Load the 

enthalpy correlation file that you saved in step 8, for example, NewCompEnthalpy.txt.  If additional enthalpy 

correlation files exist for this component, also load these correlation files by repeating this step. 

11. Proceed to “Saving Component Records” at the end of this document if no other correlations will be used for 

this component. 

mailto:simulation.support@andritz.com
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Figure 54: MP 1 Variable Curve Fitter – Raw Data – Coefficients Computed 
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Figure 55: MP 1 Variable Curve Fitter – Curve Fit Status 
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Figure 56: Enthalpy = F(T) – Sample Data Plotted – Order - 8 

 

Figure 57: Enthalpy = F(T) – Sample Data Plotted – Order - 4 
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Appendix F. Curve Fitting for Pumps and Fans 

The curve that has to be fitted should be first converted into bmp/jpeg format so that it would be easy to digitize 

(extract the points) the curve. Digitizing the curve can be done by using the Graph Digitizer present in 

TOOLS_UTILITIES library. 

F.1 Steps to be followed for Using Graph Digitizer 

1. Place the Graph Digitizer object from TOOLS_UTILITIES library onto the worksheet. 

2. Double-clicking on the object opens a window and this is used to select the graph by using the browse 

button. 

3. Click on the browse button to select the graph, which is in bmp/jpeg format that the user wishes to digitize. 

4. By selecting the curve, the corresponding curve/graph will be opened and a message is displayed. 

5. First, the user is asked to define the axes and locate them on image. The user can re-define them at any 

time by using the menu buttons and after defining the axes click on the curve to register data points. 

6. Now define the axes by entering the min and max values of X and Y axes in the fields provided and press 

OK. 

7. A message is displayed to Click on the (1) origin, (2) X-max and (3) Y-max points in the image now. “Only 

one click per item in the same order please” will appear. Press OK. 

8. Click on the origin on the graph, next on end on the X axis (X-max) and finally on the end of the Y axis (Y- 

max). Immediately a message displaying “Next click on the curve to be digitized” appears. Press OK. 

9. Now click on the curve that has to be digitized by selecting some points on the curve, and after ensuring that 

the user has selected the required number of points on the curve press the Accept and Close button in the 

menu of graph window. 

10. The points that have been selected on the graph will be extracted and those all points will appear in the 

graph digitizer window of X-Y data table. 

For more information on using this object, the user is referred to the help text. 

The data points of the curve/graph that have been extracted by using graph digitizer are used for finding the 

coefficients of the curve by using the General Curve Fitter object. 

F.2 Steps to be Followed for Using General Curve Fitter and Finding 
Coefficients of Curve 

1. Place the object named General Curve Fitter that is available in TOOLS_UTILITIES library on the worksheet. 

After double clicking on the object a window where the input data should be entered will be opened and 

enter the data points that are extracted by using the graph digitizer in the Input Data Table. 

2. Click on the Step 1: Compute Coefficients button. A message will be displayed that “The maximum 

polynomial order for the given data is **9**.” Provide additional data if order **10** correlation is to be 

determined. Press OK. The result can be seen in the Curve Fit Status table of Curve Fit Output tab. 
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3. Click on the Step 2: Show Coefficients button. A message will be displayed “Enter order of correlation valid 

orders are 1 to 9.” Now enter the value of order of the curve the user wants to fix in the box provided and 

press OK. The coefficients are computed and can be seen in Curve Fit Output tab. 

For more information on using this object, the user is referred to the help text. 

The coefficients that are calculated using this General curve fitter are used for curve fitting of fans. 

F.3 Steps to be Followed for Curve Fitting of Fans 

1. Place the object named Pump Curve Fitter that is available in PUMPS AND COMPRESSORS library on the 

worksheet. 

2. After double clicking on the object a window of Input Parameters tab where the Curve Type, Head, Flow and 

Power units are selected from their corresponding dropdown. Enter the min and max values of X and Y axes 

in their corresponding fields. 

3. In the tab of Input Parameters enter the Max. No of points that have been extracted from the graph/curve 

using the Graph Digitizer in the field provided. 

4. Select Enter X, Y Data from the dropdown menu, which is besides the Enter Data button of Step 1, press 

Enter Data button. 

5. A window where X, Y data has to be entered will be opened. Enter the X, Y data that is copied from the 

graph digitizer and paste them in the columns that are provided. 

6. Press Fit Curve button. Immediately the coefficients (results) can be seen in Curve Fit Coefficients table of 

Curve Fits tab. 

F.4 Steps to be Followed for Curve Fitting of Pumps 

Copy the coefficients that are calculated by using Pump Curve Fitter object and paste them in the Pump 

Curves dP=f (Q)/Maximum Flow Curves; Fmax=f(rpm)/NPSH Curve; NPSH=f(Q) based on the curve that 

has to be fitted. 
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